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Before you start ...

Before you start ...
About This Documentation

This documentation applies to version S22A_IC of "Prinect Image Control 4".

Prinect Image Control is a color measurement system for quality control away from the press. Prinect 
Image Control makes a spectral scan of the entire printed image. 
Any deviations from the set reference values that are detected are passed on to the press online so 
that the ink zones in all the printing units can be readjusted at the same time.

Structure of this Documentation

This documentation describes the range of functions of the "Prinect Image Control" software.

What you should already know

The user, having attended a training course, must be familiar with the "Prinect Image Control". Oper-
ation is simple by means of a touch-screen color display and does not require any special instruction.

Further Documentation

You can find more information in the following documentation:

• Heidelberg Prinect Licensing User's Guide

• Prinect 2021 documentation

Symbols and Styles

The following typographical conventions are used in this manual:

• References to other chapters and sections are blue (on the screen) and underlined.

Example: See section "Symbols and Styles", page 11.

• Quotes are used to indicate menus, folders, functions, hardware conditions, switch settings, sys-
tem messages, etc.

Example: Set the switch to "off".

• Menus, functions and sub-functions are separated by ">".

Example: Select "File > Open...".
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Before you start ...
• A plus sign is used to indicate that several keys have to be pressed at the same time.

Example: Press Alt+A.

Important Information

Important information in the text is marked by symbols that are used as follows:

Warning: Contains information that must be taken into consideration to protect the user 
from injury.

Caution: Contains information that must be taken into consideration to prevent damage to 
hardware or software.

Note: Contains important general or supplementary information about a specific topic.

Prerequisite: Lists requirements which must be fulfilled before the steps which follow can 
be performed.

�

�
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What's New?

What's New?
General

In this chapter, we would like to highlight to you briefly the main enhancements and changes in the 
current Prinect Image Control. The blue links will take you directly to more details on the topics.

What's New in Prinect Image Control S22A_IC

• Graphic representation of the measuring element for easier selection in "Service > Measuring 
device settings > Measuring elements"

• Quality Report in "Measure/Controls > Overview" replaces the Quality Monitor

• Display of Lab values for paper white in "Measure/Controls > Overview > Inking"

• Enhanced Measuring Conditions: As of S22A_IC, Image Control uses a measuring head that also 
allows measurement as per M1 standard. 
In this way, you can set M1 or M2 for color measurement in the Measuring Conditions, and M1, 
M2 or M3 for density measurement.

Note: For Measuring Condition M1, color control is possible only by way of a color control 
strip.

• Restructured "Service" UI area: for a better overview, the "Maintenance/Documentation" area 
was omitted. The "NetProfiler" is now located in "Diagnosis"; the operating manual is available 
in "Software Information".

• The dialogs in the Service area were matched to the appearance known from Press Center.

• Job data extended by "Operation" information

�

�
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Protection and Safety Information

Protection and Safety Information
Technical Remarks on Safety

Correct Use

The Prinect Image Control is to be used solely as a color measurement system for quality control in 
the printing industry. Do not place any objects or liquids on the device. Ventilation outlets must be 
kept clear at all times.

General

The Prinect Image Control may be installed only by authorized service personnel. The ambient con-
ditions must be observed.

In order to provide proper ventilation, ensure that there is sufficient distance between the machine 
and the wall or between the machine sides and other equipment when the equipment is installed.

Warning: Risk of injury!

Unauthorized opening of any parts of the housing not specifically referred to in the user's 
guide and inexpert repairs can lead to considerable danger for the user.

Servicing may only be performed by authorized personnel trained for this purpose. The rel-
evant accident prevention regulations must be observed at all times.

Non-observance of accident prevention regulations can lead to the loss of accident insur-
ance cover.
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Protection and Safety Information
Connector for Power Disconnection

The connector is a fixture for disconnecting the device from the power supply. After which the device 
is de-energized.

Warning: Danger! High Voltage! 
The device must be de-energized before all servicing / maintenance / cleaning operations 
and fault clearance.

On/Off button

The On/Off button restarts the Prinect Image Control after it is shut down through the software. You 
can also switch off the Prinect Image Control with the On/Off button by pressing the button for 
approx. 4 seconds.
16 S22A_IC



Protection and Safety Information
When you switch off the Prinect Image Control using the On/Off button, the system is powered down 
without a controlled shutdown of the internal PC. For that reason, you should always shut down the 
Prinect Image Control through the software.

The On/Off button does not de-energize the device.

Power supply line

Prinect Image Control is connected to the power supply using the power cable with power connector 
permanently connected to the rear of the device and connected to an outlet compliant with the Tech-
nical Data.

The connector and outlets of the service line must be easily accessible at all times because you must 
de-energize the device by pulling out the power connector.

Termination of the power cable is not permitted.

Protect the power cable from being damaged. Never place any heavy objects upon it and do not allow 
it to get jammed. A damaged power cable can cause leakage currents and electric shocks.

Make sure to route the cable so that there is no trip hazard.

Service

Servicing may be done solely by persons who are authorized by Heidelberg to do so.

The relevant accident prevention regulations must be observed at all times.

The device must be fully disconnected from the power supply prior to maintenance and servicing.

Warning: Risk of injury!

Never remove covers or any other parts of the casing.

Clean control console

Use a plastic and desk cleaner to clean the control console. Always apply the cleaning agent to a soft, 
lint-free cloth to clean the equipment.

Do not use abrasive cleaning agents or solvents.

Measuring Table Plate

Caution: Do not subject the measuring table plate to loading
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Protection and Safety Information
The plate on the measuring table may not be subject to loading. For that reason, do not lean 
on this plate or place any objects on it, in particular heavy parts and/or parts with sharp 
edges. Any damage to the black coating or any deformation (even if only one tenth of a mil-
limeter) can have a negative impact on your measurement results.

When cleaning the measuring table and the reference white patch, follow the cleaning 
instructions displayed for this work.

Please inform the Heidelberg service department if dirt cannot be removed.

Measuring bar

Caution: Damage to the rear guide rail when lifting the measuring bar!

Never lift up the measuring bar at the front guide rail. As the measuring bar is attached to 
the rear guide rail it would be damaged when attempting to lift up the measuring bar.

Caution: Potential damage to the front guide rail!

The guide rails of the measuring bar must always be coated with a thin film of oil. If there 
is no oil film on the rear guide rail, in unfavorable circumstances a rust film might occur. If 
there is no oil film on the front guide rail, the idler rollers of the measuring bar might tear 
out metal particles from the guide rail in the case of a dry guide rail. This might result in 
uneven positioning behavior of the measuring bar.
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Protection and Safety Information
ESD Protective Measures for Prepress Systems 
and Operators

Basics

Devices from Heidelberger Druckmaschinen AG are resistant to electrostatic discharges (within the 
limits of EN 55024:2001).

In order to protect devices and users from being unnecessarily exposed to such discharges, we have 
listed a few tips below that will help reduce the frequency and intensity of the discharges. 

Formation

In a prepress environment, this physical phenomenon occurs most frequently as a result of triboelec-
tricity. In such cases, electrostatic charges are generated when bodies that have close contact are 
separated. 

Examples: 

• Walking across non-conductive (insulating) flooring (e.g. synthetic floor covering)

• Removing the slip sheet from the plate

• Getting up off a seat

The intensity of these charges is determined basically by the following parameters:

• Humidity

• Roughness of the material surface

• Pressure/space when in contact

• Conductivity of the materials
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Protection and Safety Information
Practical Tips

The following practical tips are to help reduce the number and intensity of electrostatic discharges 
when handling the devices:

• Install the devices in rooms that have conductive floor covering. 

• Resistance to ground < 1x109 ohms (IEC/EN 61340-5). Synthetic carpeting does not comply with 
this requirement in the majority of cases. Pure concrete flooring generally has a low volume 
resistance. If you have non-conductive floor covering, the use of ESD mats placed on the oper-
ator side of the devices is recommended. These mats can be obtained from suppliers. However, 
in such a case, existing charges are only slowly reduced depending on the shoes that the per-
sonnel wear. For personal safety, the resistance of floor to ground should not fall below 105 
ohms.

• The humidity at the installation site should not fall below 45% relative humidity. High air 
humidity is a decisive factor in preventing the formation of electrostatic charges. For example, 
a relative humidity of 10 - 20% will produce 35,000 V when crossing a carpet. This value drops 
to 1,500 V with a relative air humidity of 65 - 90%.

• Clothing where cotton material is > 50%.

• Conductive seating.

• ESD shoes that can be obtained from suppliers and are used on conductive flooring help further 
to reduce charges when walking across floor coverings.

Standards/Sources

More details on this subject can be found in the following sources:

• IEC / EN 61340-5 (Protection of electronic devices from electrostatic phenomena - General 
Requirements)

• Electrostatic Discharge Association  
http://www.esda.org/

• Electrostatic Society of America  
www.electrostatics.org
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Protection and Safety Information
Hazardous Areas and Labels

Danger Labels

The Prinect Image Control has various hazardous areas that are identified by danger labels.

The following danger labels are attached to the unit:
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Protection and Safety Information
Warning: Electric shock hazard from connected device! 
While the device is connected to the in-house network or to a separate power supply of the 
print shop, some components of the Prinect Image Control are energized with a voltage of 
AC 230 V.

Warning: Electric current hazard! 
There are live parts in the Prinect Image Control base frame in the electronics slide-in units 
and on the rear near the drag chain. There is a risk of fatal injury from contact with live 
parts. Only authorized and qualified staff is allowed to work in these areas.

Inside the measuring bar there are voltage-carrying parts of less than 42 V.

Warning: Laser class 2M!

On the single measuring head there is a Class-2M laser pointer. Never look into the laser 
beam. This is particularly important when you use an optical instrument. The laser beam 
hits the measuring table immediately to the right of the measuring bar. 

A laser warning label is attached to the inner carrier plate of the measuring arm. 

Type and Test Labels

GS label for tested safety
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Protection and Safety Information
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System Description

System Description
Device Description

As a world leading system, Prinect Image Control features measurement of the entire printed images 
combined with online ink control for all printing units. Prinect Image Control can be used as a color 
measurement and control system for up to four presses. Together with the Mini Spot workflow, 
Prinect Image Control becomes a quality center. Mini Spots are measuring elements with halftone 
and full-tone fields that can be variably placed on the print sheet for color and process monitoring. 
They provide precise information about changes modifications of the color space and the dot gain on 
the print sheet.

The connection to the Analyze Point allows you to analyze the color measurement evaluations for 
each operation in the Prinect Integration Manager/Prinect Pressroom Manager. The detailed evalua-
tions can be used both as the basis for internal quality analyses and for complete quality verification 
for customers.

Function and Principle of Operation

The Prinect Image Control is a color measurement system for quality control in the printing industry. 
An optical system makes a spectral scan of the image data of a printed sheet. The results are used to 
control the ink feeding of up to four printing presses connected to the system.

Example: Control of up to four printing presses by one Prinect Image Control
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System Description
The user interface is touch-screen operated. A mouse and keyboard are used for servicing work (see 
"User Interface", page 31).

In addition data can be keyed in using the keyboard of the control panel on the measuring bar.

Introduction to the Main Components

• Control panel on the measuring bar (1)

You can control the measuring bar directly using the keypad (for details, see "Control panel on 
the Measuring Bar", page 29).

• Measuring bar (2)

The measuring bar consists of movable components that move in Y direction (from front to back) 
and in Z direction (up and down).

The measuring bar carries the following optical components:

· Image measuring unit

· Single measuring head

1

2
3

4

6
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System Description
The measuring bar also carries the following electrical components: 

· Power supply module

· Positioning motor for height adjustment

· Positioning motors for Y motions

• Measuring table (3)

The measuring table provides a surface on which to place the printed sheet that you wish to 
measure as well as a support for the X drive and a positioning system in X direction.

During the measurement process, the X drive moves the measuring bar across the entire width 
of the measuring table. The positioning system in X direction monitors the position of the mea-
suring bar.

A sheet stop edge at the front ensures that the printed sheet is positioned correctly on the mea-
suring table.

During a measurement run, the sheet is held in place by means of four suction air units.

Note: Do not place any objects within the travel range of the measuring bar. 

• Touch screen (4)

All information is displayed on a touch-screen flat monitor.

• USB ports (5)

USB ports are located on the rear of the monitor for connection of a USB stick to copy Netprofiler 
data or data for replacing the white pill (only by service technicians) to the system. A wireless 
mouse and/or a wireless keyboard can also be connected (not included in the shipment).

• On/Off button (6)

The on/off button is located on the right side of the device. If an automatic login is not set up, 
the login screen appears some time after the device powers up by pressing the button briefly. 
Initialization of the system is finished completely when the measuring system no longer moves 
for some time and when the measuring bar is at the left end of the table. 

You can also shut down the device in any operational state with the button by pressing it for 
approx. 4 seconds. However, we recommend that you shut down the device using the software 
in "Service", "Measuring device settings", "Basic settings" tab (see Shut Down System Computer, 
page 173).

Warning: Danger! High Voltage! 
The Prinect Image Control is still live after you shut it down using the software and using the 
On/Off button. For that reason, the device must be fully disconnected from the power sup-
ply by pulling out the power connector prior to maintenance and servicing.

• Power supply connection (7)

�

�
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System Description
The power cable for connection to the power supply is located on the rear of the device.

• Electronics module (8)

The electronics module is located in two slide-in units behind the front panel. The front panel 
can be opened with a special key to pull out the slide-in units for servicing.

The left slide-in unit holds:

• Three power supply modules for LED lighting, image measuring unit and single measuring head

• Hardware controller for the X drive

• Electronic load relay for the extractor fan

• 26-pin converter module

•  Terminal strip

The right slide-in unit holds:

• Power supply module for the system computer

• System computer

• Adapter transformer 115 volts / 230 volts

• Interference suppression filter

• Terminal strip

Warning: Danger! High Voltage! 
The special key for opening the front panel may be used only by authorized persons. Before 
the front panel is opened, the device must be disconnected from the power supply because 
some components of the electronics module are still live (even after the device is shut 
down).

• Foot switch (9)

The sheet suction mechanism is activated by means of the foot switch. The suction air remains 
active until a measurement is performed.
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System Description
Control panel on the Measuring Bar

The control panel for the measuring device is located on the measuring bar.

The control panel on the measuring bar has the following indicators and buttons:

• (1): Operational indicator (green)

• (2): Cancel

• (3): Move the measuring head to the rear

• (4): Move the measuring head to the left

• (5): Input

When the input button is pressed, the position to which the light pointer moves will be stored 
and, if applicable, the positioning process initiated.

• (6): Move the measuring head to the right

• (7): Move the measuring head to the front
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System Description
System Installation

General Notes

The Prinect Image Control is shipped as follows: 

• The adapter transformer in the base unit is set up for a power supply of 230 V AC.

• For safety reasons, the computer, keyboard and mouse are supplied separately. The software is 
already installed and configured.

Setting up the Display Screen

The requirements of EU Directive 90/270/EEC (a directive on the minimum health and safety require-
ments for work with display screen equipment) and the requirements of the respective national 
implementation of this directive must be complied with when the display screen is set up.
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System Description
User Interface

Operation of the Touch Screen

Normally, Prinect Image Control is operated using the surface of the touch screen. To operate the 
device, simply press your finger on the section you want on the screen. A virtual keyboard displays so 
that you can enter text, e.g. when you want to name the job.

Caution: Do not damage the touch screen with pointed objects!

Do not use pointed objects such as ballpoint pens when you operate the touch screen 
because such objects can damage its sensitive surface. Operate the touch screen only with 
your fingers or with pens that are specially designed for this purpose.

Design of the User Interface

The user interface is divided into three sections: 

• Header (main navigation bar)

• Workspace

• Footer

The information in the footer and the control elements in the header are available at all times irre-
spective of your workspace. The connected machines have color tags so that you can easily identify 
them. You will find such tags on the buttons for selecting the machine and on the stylized display of 
the machine in the footer. You can change the assigned colors in the Service section.

Control Elements in the Header

Buttons for selecting the press you want

Buttons displaying the connected presses appear on the left of the header. As many as four presses 
can be connected.
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System Description
You switch over to the press you want by pressing the button concerned and you can then edit jobs 
for this machine. If a button is dimmed, you cannot select this machine at the moment because it is 
switched off, for example.

A consistency check is run between the active job on the machine and the active job in Prinect Image 
Control every time you change to another press.

Buttons for selecting your workspace

You can switch between the workspaces for the machine you selected using the three buttons in the 
middle of the header:

• Job preparation

• Color measuring

• Malfunction/Service

Print screen button

You can save a PDF file of the current content on your screen to a share in the network by pressing 
this button. You can then output this file later to a printer. To avoid creating PDF files by mistake, you 
must press the button for at least 2 seconds.

Heidelberg logo: Button for starting the Help function

You go to the Help level when you press the Heidelberg logo. The user interface turns bluish and you 
recognize by this color that you are in the Help mode. You can now press any element and you will 
see a balloon with information about this element.
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System Description
If you want more information, you can display the Online Help with details about operation of the 
Prinect Image Control system by pressing the relevant button in the balloon.

Press the Heidelberg logo again to quit the Online Help and return to the operational mode.

Information in the Footer

An icon of the currently selected press covered with the color you assigned appears on the right of 
the footer. The date, time and machine name entered in the "Designation" box display.

The following elements are also displayed depending on status and availability:

• Preview of the scanned sheet

• Job data

• Progress bar

• Active print side

• Active machine

• Date / time
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Technical Data
Housing Dimensions and Weight

Housing dimensions (in mm)
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Technical Data
Weight

The Prinect Image Control with all its components weighs approximately 700 kg.

Electrical Data

Environmental Data

Disposal of the Device

The device must be disposed of in compliance with the relevant national regulations. The device con-
tains harmful substances. It must be handed over to an approved waste disposal company and not 
be disposed of as household waste. Addresses can be obtained from the relevant environmental 
office.

Electrical data

Permissible input voltage AC 100...240 V

Permissible frequency range 50/60 Hz

Maximum current consumption 11.8 A (230 V)

27 A (100 V)

Maximum power consumption 2.7 kVA

Environmental data

Permissible operating temperature range +10 °C to +40 °C

Permissible storage temperature range -25 °C  to +85 °C

Permissible humidity range  
(non-condensing)

max. 93% relative humidity

Noise Emission Noise emission (in compliance with DIN 45635): 
< 74 dB(A)
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Standard Workflow

Standard Workflow
Overview of the Workflow

The workflow with Prinect Image Control can be broken down fundamentally into the following steps:

• Loading of the active job from the press to Prinect Image Control

• Adding to the job data at Prinect Image Control

· PPF data

· Data from the job database

• Scanning and analysis of a printed sheet from the job at Prinect Image Control

• Transfer of the data determined at Prinect Image Control to the press for control of the ink that 
is applied.

• Regular check through renewed scanning of printed sheets and control follow-up.
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Standard Workflow
Procedure
The following description shows you step by step how to work with Image Control in the majority of 
cases. You will find details about the single sections in job preparation and image control in the chap-
ters which follow.

The simplest workflow is when you are working with PPF data in a hotfolder and are producing sim-
ilar jobs (without any ink change in the printing units) one after the other.

1. In "Job selection", load the job from the press, if necessary enable "Keep color selection" (from 
the predecessor job) beforehand. 
Image Control automatically goes to the "Zone Position" step, the "Measure" button is enabled.

2. Take the printed sheet and place it on Image Control.

3. Press the "Measure" button and check the zone position after the scan.
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Standard Workflow
4. Press "Next" and check the reference values. 
Manual assignment of the reference values is necessary only if you cannot use the reference val-
ues from the predecessor job or the default color set.

5. Press "Next". Where possible, the color separations are assigned automatically and shown 
briefly. Image Control then automatically goes to the "Measuring elements" step and finds the 
existing measuring elements.

6. Check the measuring elements and release the job. After the job is released, Image Control auto-
matically goes to the "Measure/Controls" workspace.
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Standard Workflow
The description below Load and Edit Your Job Data in Image Control shows you the workflow with 
details about each step and the differences between working with and without PPF data.

Load and Edit Your Job Data in Image Control

As many as four presses can be connected to Image Control. Image Control can show and accept an 
active job from these presses. Image Control also has a job database, from which you can load job 
data for repeat jobs. You can load only the active job and not the preparation job from the press.

1. Select the press whose print job is to be controlled using Image Control.

Normally, "Job selection" automatically displays the "machine" as the source and the job that is 
already selected. Exception: If a job was already loaded and edited on this machine, its last editing 
state displays.

2. Select the "Job preparation" workspace and the "Job selection" tab there. The job that is active 
at this press displays.

3. Press "Load job". This loads the job data from the press. 
Depending on your workflow, you now have two options:

• You are working with PPF data that are filed in a hotfolder: Prinect Image Control automatically 
goes to the first step, "Zone Position" (continue with "Zone Position", page 42). The front surface 
is selected if perfecting is enabled.

• There are no PPF data: Prinect Image Control automatically goes to the "Job data" (continue 
with "Job data", page 40).

Job data

4. In the "Job data" tab, the top part displays the job data of the press. 
You can import PPF data or reset them again in the middle part. In the lower part, you can add 
job sections or the whole job as a repeat job from the job database to the job data of the press.
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Standard Workflow
5. Switch to Job preparation. You can do this by selecting the "Job preparation" tab or with the 
"Job preparation" button.

The upper part of job preparation displays information about the job such as job number and job 
name.  
Below that, more details like printing unit colors, preview (if any) and paper grade display.

This information is shown for both sides of the press sheet on machines where perfecting is enabled. 
Job preparation must be done separately for both sides of the press sheet. You can switch between 
these two job sections by pressing the buttons for front and back.
Prinect Image Control  –  User’s Guide 41



Standard Workflow
Zone Position

6. Press the "Zone Position" button.

Another window displays, where you are guided through each step in job preparation. You will recog-
nize the section you are currently in by the marker in the header.

You move between the various steps in job preparation by pressing the "Next" and "Previous" but-
tons. "Next" is enabled only if all necessary inputs were made in the current step.

Use the "Close" button to quit step-by-step editing and return to the main window and "Job prepara-
tion".

You can also display each step from this point using the buttons on the right. Here, too, you can select 
only those buttons whose requirements were met in the previous steps.

What you see in "Zone Position" depends on whether you are working with or without PPF. When you 
are working with PPF in the HEIDELBERG workflow, no color control strip displays and after you place 
the printed sheet in position you can continue straight away with "Measure". In other words, the con-
trols for the color control strip are hidden by default and the "Measure" button is active immediately.
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Standard Workflow
Scan Printed Sheet

7. Take a sheet from the press to record it at Image Control. Depending on the press and job, you 
can do this after approx. 100 to 300 sheets have run through the press.

8. Place this printed sheet onto the measuring table. The sheet must lie as straight as possible 
along the sheet stop edge and completely over the suction air vents.

Note: Make absolutely sure that the printed sheet, even the sides of it, does not jut beyond 
the area with the suction air vents. If it does, all of the sheet will not be fixed by suction 
evenly and in some cases may not be scanned completely, leading to errors in the results.

9. Only when working without PPF data: Indicate the color control strip position and select the 
height of the control strip.

You should indicate the position of the color control strip manually. This is done using the "Top, 
Middle, Bottom" buttons or using the hand button with the help of the travel buttons on the mea-
suring bar when the laser pointer is switched on.

In order for the "Measure" button to be enabled, you must also select the height of the color con-
trol strip, either "4 mm", "6 mm" or "no color control strip".

�

�
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Standard Workflow
10. Press the "Measure" button in the "Zone Position" step. 
The printed sheet is fixed to the measuring table by suction and the measuring bar starts the 
scan.

The printed sheet is scanned in two runs, during the forward and return motion of the measuring bar. 
Prinect Image Control then calculates the data and determines the position of the color control strips. 
While scanning is going on, a preview of the scan appears gradually in the window as the data 
become recorded. Text below the scanned image informs you briefly about the currently running pro-
cess.

The "Measure" button changes to "Cancel" during scanning and when looking for control elements.

Scanning is finished when the "Measure" button is active again and when you can select the "Next" 
button. The reproduced sheet is aligned automatically and shown with the ink zones.
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Standard Workflow
After scanning, the paper white found displays as a hue and its Lab values. The areas on the sheet 
where this paper white was found are highlighted by flashing yellow.

(11). The zone position is sent from the press to Image Control. If you wish to change the zone posi-
tion on autonomous machines, go to the manual mode and shift the zones in steps of 1.5 mm.

12. Press "Next" to check the assigned printing unit colors in the "Reference values" step.

In the following cases, the reference values are already assigned:

• If the reference values of the default color set match the current job.

• If the reference values of the predecessor job match the current job and the "Keep color selec-
tion" option is enabled.

• In the case of jobs loaded from the internal database, the boxes show the assigned reference 
values of the stored job.

In these cases, you only have to check whether the automatic assignment suits your needs and then 
press "Next" (continue with "Color separations", page 47). Assignment of the reference values as 
described below is necessary only if the reference values could not be defined (e.g. because of an ink 
change on the press) or if you want to set other values.
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Standard Workflow
13. Press one of the boxes in the "Color set" column. By doing this, you display the "Assign set-
points" window.

14. In the "Assign setpoints" window, select the colors that match the inks used in the printing units.

15. Open the color set you want in the color database and mark the row that you wish to assign to 
the currently active color. You will recognize the color that is currently selected by the white 
background of the button shown on the left.

16. Press the "Assign" button.

17. Now select the next color button and assign all the colors as you want one after the other.

18. You can assign all colors whose names match those of the reference values directly at one go 
by pressing the "BCMY" button.
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Standard Workflow
After all the colors are assigned, close the window by pressing the OK button.

Color separations

This is where color separations are assigned to the printing units. Normally, after the separations dis-
play briefly, Prinect Image Control automatically goes to the "Measuring elements" step. You can find 
a more detailed explanation in "Color separations", page 90.

Measuring elements

19. Press "Next" and in the next step check the control elements (measuring elements) determined 
automatically by Image Control.

20. Check whether all the control elements were detected correctly.

The detected elements are listed in the table to the right of the scanned image. Select one of the con-
trol elements in the table. You will then see the position of this element in the scanned image high-
lighted by a flashing frame.

You can disable single control elements from control or delete them or manually assign elements that 
were not detected.
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Note: The controlled variables are recalculated only when you trigger a new scan in "Mea-
sure/Controls". When you trigger a new scan at this point in job preparation, the system 
also starts a new search for control elements ("Measuring elements"). This can cause man-
ual assignments or enabling/disabling of the control elements to be revoked.

Note: By default, only color control strips are used for control. 

21. When all necessary requirements are met, you can enable the job by pressing the "Release job" 
button. Image Control automatically goes to the "Measure/Controls" workspace.

Note: Job release only concludes job preparation at Image Control. No control data are sent 
to the press at this point. 
For jobs with two sides per sheet, you can release each side separately.

�

�

�
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Standard Workflow
Measure and Controls

The "Measure/Controls" icon is now enabled in the header. In the "Measure/Controls" workspace, 
Image Control first shows an overview of the inking. Normally, all the colors are enabled for control.

Note: Take note of the following item relating to density values: You must measure the den-
sity on solid tint areas (preferably polarized), in other words, generally on color control 
strips.

22. Check the calculated controlled variables.

23. If you wish, restrict ink control by deselecting single printing units or locking single zones.

24. Press a color button if this color is to be excluded fully from control. A color is disabled if its color 
button no longer has a white background (C2 in the example shown).  At least one color must 
be enabled so that the controlled variables can be sent to the press.

25. Press the "Manual mode" button in the navigation bar if you wish to cut off (lock) single ink 
zones from control. You can then select zones for one or more colors and exclude them from ink 
control by pressing the "Lock" button.

26. Press the "Run control" button to send the data from Image Control to the press and to readjust 
the ink applied by the printing units.

27. During the print job, take another sheet from the machine at regular intervals and measure this 
at Image Control:

�

�

Prinect Image Control  –  User’s Guide 49



Note: When you do this, you do not have to go to job preparation again, but can record the 
sheet directly in "Measure/Controls".

The intervals at which you take printed sheets again and analyze them at Image Control depends 
basically on your press and on the job concerned. These intervals should be greater in cases where 
ink feeding is at a higher rate than at a lower rate.

28. Place the printed sheet on the measuring table. The sheet must lie as straight as possible along 
the sheet stop edge.

29. Press the "Scan" button in the navigation bar. After the scan, the controlled variables are recal-
culated and can be edited or sent to the press for ink follow-up.

30. Repeat this measure and readjustment step on new printed sheets until you have the results you 
want.

Archive Job Data

You can archive the settings of the current job to use them later in a repeat job.

31. Press "Job" in the header.

32. Press the "Save job" button.

The job is filed with its current settings in the internal database.
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Job

Job
Information about the "Job" Workspace

You go to the "Job" workspace by pressing the "ABC" icon in the header. The procedure for managing 
and editing jobs is the equivalent to a user-assisted workflow (Wizard).

First, you load job data from the press for job preparation. After that, you can load any advanced job 
data:

• PPF data

• Data from the job database

The "Job" workspace has three areas of activity that you can select by pressing the relevant tab or 
that you move to automatically from left to right:

• Job selection: This is where you can load jobs directly from a connected press.

• Job data: This displays the job data of the connected press. You can add or reset PPF data. You 
can also load a saved job or parts of a job from the database.

• Job preparation: This is where you set up the workflow for job preparation. Afterwards you can 
release the job for further processing. Front and perfecting sides are handled separately, and you 
can switch between them in this tab. It is also possible to release a single front or perfecting side 
for further processing. You can save the job after it is released.
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Job selection
You can load jobs in the "Job selection" tab.

Prinect Image Control can show and accept an active job from as many as four connected presses. 
You can load only the active job and not the preparation job from the press.

Select the press with the job you are going to process by pressing the icon for that press.
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"Job data"

This section displays the default job data (job number, job name, operation, customer name, quantity, 
sheet size and sheet thickness). The job number is always required for production data acquisition 
because it identifies the job.

If you loaded a job to an autonomous press (simulation), you can overwrite its data if required, To do 
this, press the relevant text box and type in your changes using the virtual keyboard.

Details about the printing material (sheet size and thickness) display in a diagram on the right. In the 
case of an autonomous press, you must type in the sheet size using the virtual keyboard. To set the 
width, press the button on the right and overwrite the value displayed. To set the sheet height, press 
the lower button and overwrite the value displayed. The sheet thickness is measured automatically 
before the first scan.

If the press transfers incorrect values for sheet size and thickness, you can correct these values man-
ually.

Paper Grade/Special Material

The paper grade ("Glossy coated", "Matt coated" or "Uncoated") displays separately for the front and 
perfecting side. You can change this by selecting one from the list. Any thumbnails sent by the press 
display in the "FrontSide" and "PerfectingSide" boxes.

The "Special Material" button switches to a special make-ready workflow that is required for metallic 
printing materials or transparent foils. The information is not sent by the press and, for that reason, 
you must set it manually for each side (front and/or perfecting).

In this mode, color is controlled solely through the measured data of the color control strip.

This button must always be used when you are working with opaque white below the color control 
strip.

Note: When you are working with special materials, paper white does not display in the 
"Zone Position" step. Paper white is determined automatically. When working with opaque 
white, make sure that you set the opacity function for opaque white in the color set (see 
"Opaque colors", page 77).

"Load job" Button

When you press the "Load job" button, all the settings for this job are applied and you go automati-
cally either to the "Job data" tab (see "Job data", page 55) or (if PPF data are in the hotfolder) directly 
to the "Zone Position" step (see "Zone Position", page 66).

�
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Job
Note: You must reload the job if you change the settings subsequently. Any previous set-
tings will be lost!

"Keep color selection" Button

• When you press this button, the reference values are taken automatically from the predecessor 
job if they match the current job. 

• If the reference values of the predecessor job do not match the current job, the reference values 
of the color set defined as the default color set are assigned. The default color set is also used 
if the "Keep color selection" option is not enabled (see "Buttons in Color archive", page 175 > 
Select as default).

• If these values also do not match the current job, this is indicated in the "Reference values" step 
and you must assign the reference values manually.

�

�
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Job data
The "Job data" tab displays the job data of the current press and you can add PPF data and/or job 
sections to them.

"Job data"

The top part of the window displays the job data of the current press. You cannot make any changes 
to it. Any available thumbnails display in the "FrontSide" and "PerfectingSide" boxes.

"PPF Data Directory"

If the press also sends an ID for the PPF data, this PPF is loaded automatically and displays in the 
middle part of the window. This is where you can import PPF data or reset them again.

Press the "PPF import" button to open a window of the same name where you can select the PPF data 
and assign the sheet side you want (see ""PPF import" Window", page 57)..

The related job data ("Job number", "Job name", "Sheet ID" and "Date") and thumbnails then display 
beside the button.

The "Reset" button is enabled only if PPF data were assigned to the job. Any assigned data (for both 
sides at the same time) are deleted when you press this button.

Note: In the "PPF import" window, you assign or delete PPF data separately for the front 
and perfecting side. 

�
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"Load job sections"

Prinect Image Control has a job database where jobs can be stored. You can load job data from this 
job database for repeat jobs. In the lower part of the window, you can load the job or parts of the job 
from this job database.

Press the "Load job sections" button to open the "Load job sections from database" window. This is 
where you can load the following job sections:

• Reference values

• Measuring elements

• Zone profile

(see ""Load job sections from database" Window", page 59).

Press "Load job" to open a window of the same name where you can load a complete job.

If the stored job contains PPF data, this data will also be loaded.

Note: You can edit the job database (e.g. copy or delete jobs) in "Service > Integration/Sys-
tem > Job list". 

"Job preparation"

When you press the "Job preparation" button, all the settings are applied to this job, and you go auto-
matically to the "Job preparation" tab (see "Job preparation", page 63).
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"PPF import" Window 

You can select job data separately for the front and/or perfecting sides of the sheet in the "PPF 
import" window.

When you select an item, the related preview displays to the right of the table as well as the icon indi-
cating whether it is "Front" or "Perfecting".

Filter for table view

Above the table, you can type a string by which to filter the table contents. With the button to the 
right, you enable or disable the filter function.

PPF directory

Select the folder containing the PPF files you want from the small list box at the top right.

"Job data"

The bottom left part of the window displays the job data of the current press. You cannot make any 
changes to it.

Assignment

In the bottom right part of the window, you can use the arrow buttons to assign the selected job sec-
tions of the marked side in the database to a side in the current job: right for the front side and left 
for the perfecting side.

The current assignment plus preview displays to the right of each button.
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Note: PPF data can be filed in any folder. To access this folder, you must create a hotfolder 
by defining a "PPF input directory". To do this, you must go to "Malfunction/Service > Inte-
gration/System > Prinect Configuration" and display the "PPF input directory" window by 
pressing the button of the same name. The "Create" button in this window lets you link a 
new PPF input directory to the PPF folder or you can customize an existing PPF input direc-
tory with the "Edit" button (see Integration/System).

The job data in the folder you selected (job number and name, sheet name, date and the color sep-
arations set for the front and/or perfecting sides) are shown in the list. When you press the row with 
the job data you want, these data are selected and they display together with a preview to the right.

A PPF file has two items in the table if this file contains data for the front and perfecting sides: one 
item for the front side and one for the perfecting side. This makes it possible to load PPF data for front 
and perfecting sides from different jobs.

Use the right arrow button to apply the selected PPF file to the front side and the left arrow button to 
the perfecting side.

The current assignment plus preview displays to the right of each button.

This button lets you delete assigned data.

Press the OK button to apply your selection to "Job data > PPF Data Directory" and return to "Job 
data".

Use this button to discard your selection and return to "Job data".
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"Load job sections from database" Window

You can select job data separately for the front and/or perfecting sides in the "Load job sections from 
database" window.

The table shows the job database with all the jobs that match the job data and can be loaded from 
the press.

The following jobs do not display:

• Jobs whose sheet size in the database is bigger than the sheet size of the press. A tolerance of 
10 mm was introduced for this.

• Jobs where the number of printing units in the database is bigger than the number of printing 
units of the press.

• Jobs that have a different printing material quality to the one set for this job.

• Jobs that have a different off-center position to the one set at the press.

Jobs with front and perfecting sides have a separate item in the table for each side.

When you select an item, the related preview displays to the right of the table as well as the icon indi-
cating whether it is "Front" or "Perfecting".

Above the table, you can type a string by which to filter the table contents. With the button to the 
right, you enable or disable the filter function.

You can load reference values, measuring elements and a zone profile as job sections. 

As there is no sense in loading measuring elements or zone profiles without reference values, you 
must enable the reference values first of all. Then the measuring elements and, if necessary, the zone 
profile are enabled.

The zone profile is not enabled if no zone changes were made in the job from the database.

You enable the job sections to be loaded by pressing the relevant buttons.
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In the lower part of the window, you can use the arrow buttons to assign the selected job sections of 
the marked side in the database to a side in the current job: right for the front side and left for the 
perfecting side.

The current assignment plus preview displays to the right of each button.

This button lets you delete assigned data.

Use the OK button to load the assigned job data to the current job and display them in "Job data > 
Load job sections".

Use this button to discard your assigned data and return to "Job data".

"Load job" Window

You can select the data of a complete job separately for the front and/or perfecting sides in the "Load 
job" window.
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The table shows the job database with all the jobs that can be loaded from the press for this print job.

The following jobs do not display:

• Jobs whose sheet size in the database is bigger than the sheet size of the press. A tolerance of 
10 mm was introduced for this.

• Jobs where the number of printing units in the database is bigger than the number of printing 
units of the press.

• Jobs that have a different printing material quality to the one set for this job.

• Jobs that have a different off-center position to the one set at the press.

Jobs with front and perfecting sides have a separate item in the table for each side.

Above the table, you can type a string by which to filter the table contents. With the button to the 
right, you enable or disable the filter function.

When you select an item, the related preview displays to the right of the table as well as the icon indi-
cating whether it is "Front" or "Perfecting".

In the lower part of the window, you can use the arrow buttons to assign the job data of the marked 
side in the database to a side in the current job: right for the front side and left for the perfecting side.

The current assignment plus preview displays to the right of each button.
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This button lets you delete assigned data.

Use the OK button to load the entire job. 

You go to the "Measure/Controls" workspace if the loaded job was already released in job prepara-
tion. 

You go to the "Job preparation" workspace if the loaded job was not yet released in job preparation.

The loaded job displays in "Job data > Load job". Any PPF that was also saved is loaded and displays 
again.

Use this button to discard all assigned data and return to "Job data".
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Job preparation

The upper part of job preparation displays information about the job (job number, job name, cus-
tomer name, quantity and paper geometry).

Below this, you will find the two buttons for switching between the front side and the perfecting side. 
Job preparation is done separately for both sides of the press sheet on machines where perfecting is 
enabled. You can release the sides separately. Job preparation displays automatically for a side that 
is not yet released when you go to this side in "Measure/Controls".

The assigned colors are indicated by circles in the appropriate colors. No colors are assigned so far if 
all the circles are empty.

Any existing preview of the press sheet displays below the assigned colors. PPF job and/or special 
printing material displays to the right if these options are selected:

The printing material quality selected during job selection displays below the previews.

The make-ready workflow with the steps required for job preparation displays on the right.

"Save job"

The currently loaded job is stored as a template for repeat jobs when you press the "Save job" button. 
Saving is only possible in the "Job preparation" tab. You should save the job data only when you are 
satisfied with your settings for printing. If you save your job at an earlier stage, then the current pro-
cessing state of the job is saved.
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You can then load the job data (for example, reference values or measuring elements) for a repeat 
job and do not have create a new job again right from the start. Repeat jobs can be jobs that were 
not yet approved by the customer at the time the job was finished and have to be repeated with cor-
rections or are jobs that will be reprinted at a later point in time with minor changes (e.g. different 
prices or different date).
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Make-ready Workflow for Job Preparation

Job preparation consists of the following steps:

• Zone Position

• Reference values

• Color separations (only in the PPF workflow)

• Measuring elements

Use the buttons on the right to display the single steps in job preparation directly. Some requirements 
for a certain step still have to be met if the buttons are disabled (dimmed). For example, you cannot 
select the buttons from "Reference values" to "Measuring elements" if a printed sheet was not yet 
scanned. The single steps are enabled for operation, depending on the stage you are at.

Jobs with PPF data in addition require the "Color separations" step in job preparation compared to 
jobs without PPF data.

The make-ready workflow displays below the header in a progress bar, with the current step high-
lighted in color.

After all necessary steps are done, you can release the job to color control by pressing "Release job" 
in the "Measuring elements" step. This concludes job preparation on Prinect Image Control, but no 
control data are sent to the press at this point.

The "Measure/Controls" icon is enabled in the header and you go automatically to this workspace.
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Zone Position

Definition of the zone position is your first step in the make-ready workflow. The printed sheet is 
scanned and recorded for the first time in this step.

When the "Zone Position" window is open, the single measuring head moves automatically to the 
position of the color control strip in a job with PPF.

1. Place the printed sheet onto the measuring table so that it lies as straight as possible along the 
lower sheet stop edge.

Note: Make absolutely sure that the printed sheet, even the sides of it, does not jut beyond 
the suction holes because it cannot be fixed by suction fully and evenly and scanned if it 
does.
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2. Press the "Measure" button.

The printed sheet is fixed to the measuring table by suction and the measuring bar starts the scan. 
The printed sheet is scanned in two runs, during the forward and return motion of the measuring bar.

While scanning is going on, an image appears gradually in the window as the data become recorded. 
Text below the scanned image informs you briefly about the currently running process.

The "Measure" button changes to "Cancel" during scanning. This lets you cancel scanning if you 
want.

Show color control strip position
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You can manually show the position of a color control strip by pressing this button. If a color control 
strip is found in the PPF file, the single measuring head moves to the position of this strip. The color 
control strip is shown by a green bar.

Positioning is always to the lowest color control strip if the PPF file has more than one strip.

There are color control strips with two different heights:

• normal color control strips 6 mm high and

• micro color control strips 4 mm high

The height of the color control strip displays beside the scanned image in the selected button (white) 
and can be edited.

In certain boundary conditions, it may be feasible to disable position tracking of the single measuring 
head. This is done by pressing the "Position tracking" button. Normally, position tracking is enabled 
(button has white background).

To exclude the data of the single measuring head, for example, if solely image control is to be used 
but not control by color control strips, press the "No color control strip" button: Tracking and color 
control strip height are disabled.
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Press the "Top position", "Middle position" or "Bottom position" buttons to move directly to the top, 
middle and bottom control strip positions on the sheet. You can also move to the position by moving 
the green bar. Whenever you press one of these buttons or move the green bar, suction is enabled, 
the single measuring head moves to the set position and the laser in the single measuring head 
switches on.

The keyboard on the measuring bar is enabled, and you can use the arrow keys to move to the posi-
tion of the color control strip.

The current control strip position displays as the distance from the lower edge of the sheet. 

Showing the color control strip position and height is needed mainly for jobs without PPF.

To modify the zone position

In this case, the off-center position sent by the press displays to start with. If the press did not send 
any off-center position, the sheet is centered automatically by the application. Normally, you can 
accept the suggested zone position.

If necessary, at this point you can correct the suggested zone position to the right or left in steps of 
1.5 mm using the two arrow buttons, for example, if you are not printing at the machine center.
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When the zone position is modified, you can press the "Apply" button. The set value for the zone posi-
tion is then applied.

Scanning is finished when the "Measure" button is active again. The reproduced sheet is aligned 
automatically and shown with the ink zones.

The second step in the make-ready workflow, "Reference values", displays when you press the "Next" 
button.

Suctions stays on, holding the sheet in its position on the measuring table and letting you show colors 
of the current sheet and measure them with the single measuring head.

"Export image inspection data" button

You can export the image inspection data directly after the first sheet scan. The data of the sheet scan 
present in the BME are buffered and then written to the network folder that is set up as the hotfolder 
(200 dpi image data and an .xml description file).

Prerequisite: To use this function, the "Offline Inspection" license must be enabled and a 
hotfolder set up as "Inspection Output folder" in "Service > Integration/System > Prinect 
Configuration".

For a more detailed description, see "Overview > Export Image Inspection Data", page 116.
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Show paper white

Note: When you are working with special materials (see "Paper Grade/Special Material", 
page 53), paper white does not display in the "Zone Position" step.

After scanning, the paper white found displays as a hue and its Lab values. The areas on the sheet 
where this paper white was found are highlighted by flashing yellow.

Press the "Show paper white" button on the left if you wish to show a different paper white. This but-
ton will have a white background.
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Set paper white manually

You can use the top three buttons to change the display of the scanned image in order to look at cer-
tain sections more closely:

• When you press the left and middle magnifier button, the scanned image is scaled up (+) or 
down again (-) in five steps.

You can move the full or scaled-up scanned image as desired within the display (keep your fin-
ger pressed on the touch screen during this action).

• The full scanned image displays again and is centered when you press the right magnifier but-
ton.

A color patch and the "Apply" and "Reset" buttons display below the paper white display.
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A color data tool (pipette) appears in the scanned image, and you can move it as desired within the 
display. The value below the color data tool displays as color in the patch. Identical color values are 
highlighted in the image by flashing yellow.

The new value for paper white is applied when you press the "Apply" button. The paper white that 
was determined automatically is replaced by the color patch and Lab value in the display above.

The original paper white that was determined automatically displays again when you press the 
"Reset" button. The color data tool, the color patch and the buttons hide again when you press the 
"Show paper white" button again.
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Reference values

You should always set a reference value for each color of a printing unit. Reference values are nor-
mally assigned from the color database. However, you can also enter them directly as Lab values or 
take them from the current sheet or a sample sheet.

Depending on your workflow, the reference values can be assigned in different ways:

• If "Keep color selection" is enabled in "Job selection", the reference values of the predecessor 
job are used automatically if they match the current job.

• If the option is disabled or the reference values of the predecessor job do not match, then the 
reference values of the color set defined as the default in the color database are used.

In both cases, you can simply press "Next" in the "Reference values" step if you do not wish to 
manually edit the automatic assignment.

• The reference values display as "not defined" if no matching reference values are found auto-
matically and only then do you have to assign them manually.

The color set you select depends on the inks actually used in the printing units. Consequently, you 
can in principle select reference values from another color set for each single color. You are not com-
pelled to select all the colors from the same color set.
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In the "Reference values" window, you can assign the desired reference values as follows:

• You display the "Assign setpoints" window by pressing one of the boxes in the "Color set" col-
umn. In this window, you take the reference values from the color database (see ""Assign set-
points" window", page 78).

• You display the "Lab input ..." window by pressing one of the Lab boxes in the "Reference val-
ues" column. This lets you enter the reference values directly as Lab values (see ""Lab input" 
window", page 79).

• You display the "Reference values from sheet" window by pressing the pipette button (bottom 
right). This is where you can determine the reference values by measuring a color on the current 
printed sheet or another sample sheet (see ""Color measuring" (reference values from sheet) 
window", page 81).

Note: If a MDS is configured, you can select between "Local" (color archive stored on this 
computer) or "Server" (central color master database) settings (see "Central Color Master 
Database", page 184 for details).
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Select a process standard

Use the list box at the bottom right to select a predefined process standard for the process colors or, 
if required, a process standard for "Multicolor" (quality printing with as many as three additional pro-
cess colors, red or orange, green, blue) or "Spot Colors" (printing with additional solid tint spot col-
ors).

Note: You will find a detailed description of the process standard and the information 
shown in this overview in the section Overview > Quality Report.

Buttons and their functions

The following functions are applied by pressing the buttons at the bottom right of the "Reference val-
ues" window:

Use this function to define that a selected color will no longer be matched to paper white. Such colors 
are tagged by an icon beside the color name.

The colors currently assigned to the selected printing units are deleted when you press this button.
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The window for measuring reference values from the current sheet or another sample sheet opens 
when you press this button (see ""Color measuring" (reference values from sheet) window", page 81).

The window for saving colors or color sets in the color database opens when you press this button 
(see "Saving a Color Set", page 86).

Opaque colors

You indicate an opaque color that covers other colors when you press this button. Typical opaque col-
ors are opaque white and colors with metallic pigments.

In the Special Material mode, opaque white printed below the color control strip must be tagged as 
the opaque color. Then inking and the resulting control will be calculated correctly.

In the standard measurement mode, you must indicate opaque process colors with this button. Areas 
of other colors printed below this color are ignored during color control.

In the Lab reference values view, this color is indicated by a smaller sized display of the button.
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"Assign setpoints" window

1. Press one of the boxes in the "Color set" column in the "Reference values" window.

The "Assign setpoints" window displays.

2. In the "Color set/Ink" column in this window select the color set to match the ink actually used 
in the printing unit.

3. In the table, mark the row that you wish to assign to the currently active color. You will recognize 
the color that is currently selected by the white background of the button shown on the left.

4. Press the "Assign" button.

5. Now select the next color button and assign all the colors as you want one after the other.
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You can select all of the four process colors and assign them directly at one go from a color set by 
pressing the "BCMY" button.

6. After all the colors are assigned, close the window by pressing the OK button.

Use the "Cancel" button to discard your settings.

"Lab input" window 

It is also possible for you to enter the reference values directly as Lab values.

1. To do this, press the relevant "Lab" box for a printing unit color in the "Reference values" col-
umn. 

The "Lab input" window opens.
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2. Press the "L", "a" and "b" buttons one after the other and enter your values using the number 
keys.

The colors displays in the patch so you can check it after you entered the values.

3. Confirm your input with the OK button.

The window closes and the Lab value for the color you selected displays in the "Reference val-
ues" column.

Use the "Cancel" button to discard your settings.
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"Color measuring" (reference values from sheet) window 

1. In the "Reference values" window press the button showing the pipette.

The "Color measuring" window displays. In this window, you can measure the reference values 
directly from the current sheet or another sample sheet.
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Display of scanned image

You can use the top three buttons to change the display of the scanned image in order to look at cer-
tain sections more closely:

• When you press the left and middle magnifier button, the scanned image is scaled up (+) or 
down again (-) in five steps.

You can move the full or scaled-up scanned image as desired within the display (keep your fin-
ger pressed on the touch screen during this action).

• The full scanned image displays again and is centered when you press the right magnifier but-
ton.

Determine paper white

After this window opens, the paper white determined in "Zone Position" displays as a hue and as a 
Lab value.

Measure paper white again

The color data tool can be seen in the scanned image.

1. To measure paper white again, press the "Paper white" button on the left. 

This button will have a white background.

1. Move the color data tool to the position you want. If necessary, use the magnifier buttons to 
scale up or scale down the scanned image.

The new paper white displays as a hue and as a Lab value.
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2. Press the "Assign" button.

The single measuring head measures paper white at the indicated position and assigns it.

Measure printing unit color

The printing unit color to be measured is selected in the table below the scanned image. Normally, 
the first unassigned color from the top is enabled. You can, however, select any other color you wish.

1. Move the color data tool to the position in the scanned image where you will measure the color. 
If necessary, use the magnifier buttons to scale up or scale down the scanned image.

The color displays as a hue and a Lab value beside the button with the three dots.

2. Press the "Assign" button.

The single measuring head measures the color at the indicated position and the color is assigned 
to the printing unit.

If necessary, you can modify the density filter and density value of the selected printing unit color 
by pressing the respective boxes and correcting the setting in the "Filter" and "Density" windows 
that appear (see ""Filter" window (change density filter)", page 85 and ""Density" Window", 
page 86).

3. Repeat the procedure for all printing units that are not yet assigned a color.

Scroll buttons
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Use these buttons to scroll through the table to the printing unit colors you wish to measure. The yel-
low warning sign indicates that one or more printing unit colors are not yet assigned in this direction.

Sheet change

Use this button to change a sheet.

Suction is switched off and you are prompted to change the sheet. The "Scan" button is enabled. You 
can now scan a sample sheet. In this measure run, the first thing you have to do is show and measure 
paper white.
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"Filter" window (change density filter)

You can display the "Filter" window in "Color measuring" by clicking the filter box when a color is 
selected. This is where you can select the density filter of a different process color by pressing the 
button of the process color you want and confirming your selection with the OK button.
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"Density" Window

You can display the "Density" window in "Color measuring" by pressing the density box when a color 
is selected. You can modify the density value by increasing or reducing the value with the plus and 
minus buttons respectively and confirming your setting with the OK button.

Saving a Color Set

1. In the "Reference values" window, press the button for saving colors or color sets to the color 
database.

Note: This button is enabled for use only when one or more colors are selected in the left 
column.

The "Save Ink Set" window opens. This is where you can modify or add to an existing color set 
or create a new one.
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In the field, a color set is mainly used only with one particular paper grade. For that reason, in Prinect 
Image Control the color set is assigned to the relevant printing material quality.

The printing material quality displays in the list box at the top left (e.g. "Glossy coated") and this is 
where you can select the quality you want. Press the arrow to expand the list. You can set any text 
filter using the text box to the right of the paper grade: When you press the "Filter active" button, only 
those color sets that match the paper grade and filter setting display; in other words the text you 
entered is found in the folder, color set or ink name. Press the filter button again to disable the filter 
and view all the data again.

The table below lists all the color sets stored in the color database for the selected material quality. 
The color sets shipped with Prinect Image Control are read-only and you cannot modify, add to or 
delete them. The lock in the right column of the left table indicates this.

When a selected color set opens, the colors in this color set display, showing a color sample and Lab 
values.

The selected colors of the current job display in the right table. You cannot edit the printing material 
quality in this window. It is identical with that of the job.

Add to an existing color set

You can extend an existing color set by adding new colors to it.

1. On the left, select the printing material quality matching the current job.

2. In the left table, mark the color set that you wish to add to.

3. Then select one or more colors from the job in the right table.
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Note: Colors with the same color name as in the color set are highlighted by a yellow warn-
ing sign. When you add a color with the same name, an alert message displays, informing 
you that the reference values will be changed. The values are overwritten only when you 
confirm this message with OK.

4. Press the arrow button to add the selected color to the color set.

5. Confirm the data you assigned with the OK button.

The window closes and you return to the "Reference values" step.

You cannot edit paper white. This is indicated by a lock. 

The colors are matched to the paper white of the color set according to the paper white values. As a 
result, they can have slightly deviating Lab values.

Create a new color set

You can create a new color set, for example, if you wish to store the reference values of the current 
job to the color database to use these values later for other jobs.

1. On the left, select the printing material quality matching the current job.

2. Select the directory in which the new color set is to be saved in the left table.
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3. Press the "Create new color set" button.

4. Using the virtual keyboard, type a name for the new color set and press the OK button. 

5. From the right table, select all colors of the current job that will be saved to the color database 
(see also "Add to an existing color set", page 87).

Note: Paper white must be assigned at all events to the new color set. If this is not done, 
you cannot use the arrow button. 

Rename color

When you press this button, a virtual keyboard displays that you can use to change the name of the 
color set or color by overwriting it. You cannot rename colors that are in the color sets shipped with 
Prinect Image Control. The button is disabled if such a color is selected in the table.
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Color separations

Color separations are assigned to the printing units in this step.

Note: The "Color separations" step is found only in the PPF workflow. 

In the case of jobs with PPF, the color separations of the PPF display in the right column.

If all the separations of the PPF were able to be assigned automatically based on their names, then 
no further operation is required and Prinect Image Control automatically goes to "Measuring ele-
ments" after the separations display briefly. If necessary, you can of course return to "Color separa-
tions" from "Measuring elements" with the "Previous" button, for example if you wish to edit the auto-
matic assignment.

You can view the single separations as grayscale images in this window. The color separation shown 
is highlighted in the list. You can view another color separation by selecting a different color in the 
list.
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After all color separations are assigned, you can trigger calculation of the color image with this but-
ton. The selection in the list is dimmed, and the color image displays.

Note: Calculation of the color image may take a few seconds. 

Display of scanned image

You can use the top three buttons to change the display of the scanned image in the color image and 
in the color separations in order to look at certain sections more closely: 

• When you press the magnifier button, the area around the center of the scanned image is scaled 
up (+) or down again (-) in five steps.

You can move the full or scaled-up scanned image as desired within the display (keep your finger 
pressed on the touch screen during this action).

• The full scanned image displays again and is centered when you press the "Show preview 
image" button on the right.
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Assignment of the separations to the printing units

When you press this button, you can modify assignment of the separations to the printing units. This 
button is enabled automatically if it was not possible to automatically assign all the separations.

Below the image you can view a stylized view of the press and the colors assigned to its printing units. 
Unassigned printing units are highlighted by a yellow warning sign.

Unassigned separations in the list also have yellow warning signs.

Select the color separation that you wish to assign. Then select the printing unit that you will assign 
this color separation to. Repeat this step until all the separations are assigned correctly.

You can revoke an assignment by pressing this button.
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Blocking masks for reflecting colors

If you have a reflecting color such as "Gold" or "Silver", it is not possible to control this separation. 

In the case of a reflecting color, this button lets you create a geometric blocking mask for control in 
the image. Everywhere in the image where this color occurs, control is locked for all the colors. Such 
locked sections are shown by a red mask in the "Image Areas" step.

This button lets you create an inverse blocking mask.

Special feature: Printing in two or more runs

For example, you are going to print a job with eight colors on a four-color press. In this case, only the 
separations involved are assigned in the first print run. In the second print run, the colors for the 
printing units are assigned.

In addition, the colors already printed are assigned from the color database with this button. To do 
this, select the separation already printed and then press this button.

The color database displays and you assign the separation a value from the color database. If you do 
not do this, the calculated color image does not match the measured image and the image control 
functions that you have with PPF data are disabled.

Calculation of the color image

The "Next" button is enabled for use after you assigned a separation to all the printing units in this 
step.

The color image is calculated (if not done already) when you press this button. Then a check is made 
to see whether the PPF image and measured sheet match. 

If they match, you go to the next step, "Measuring elements".

An error message is issued if they do not match.

• You can then continue working, with control solely through a color control strip.
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• You can also check assignment of the separations and correct them, if required. The color view 
in the "Color separations" window is helpful in this case.

• Or you go back to the "Zone Position" step and measure the correct sheet.
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Measuring elements

Control elements (or measuring elements) are predefined color areas that comply with a certain spec-
ification and are positioned on the press sheet in addition to the image (see "Types of control ele-
ments", page 95).

The position and type of the control elements ("Measuring elements") in the image must be recog-
nized so that they can be evaluated correctly. The image is analyzed during scanning of the sheet and 
the position of potential control elements is determined. In this process, each potential measuring 
area is compared with the control element types stored internally and enabled for use in "Malfunc-
tion/Service > Measuring device settings > Measuring elements".

In a job with PPF, the application automatically looks for all the color control strips, minispots and 
masks in the PFF file. All the control elements that are found display in the list to the right of the 
scanned image, flashing orange. Select an item in the list. You will then see this control element in 
the image highlighted by a flashing area on top of the control elements.

In a job without PPF, the application automatically looks for all the color control strips enabled in the 
"Measuring Elements Used" list in the Service section. You must show minispots and masks manually 
("Service > Measuring device settings > Measuring elements", see page 187).

Types of control elements

In Prinect Image Control you can define and evaluate three different types of control elements:
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• A color control strip consists of a series of patches that are recurrent. The patches are always 
arranged from right to left, but there are no rules about which patch is the start of the control 
strip. The control strip basically consists of one row, is always positioned horizontally and usu-
ally goes across the entire sheet. It can be used for ink control.

• A control block or minispot consists of one or more patches. These can be arranged in any 
direction (from left to right, from right to left, from bottom to top, from top to bottom). Control 
blocks are not recurrent. The sequence of the patches is clearly defined in the control block defi-
nition.

• A mask or test chart can have several patches that are generally arranged in a number of lines. 
There may also be gaps, in other words, it does not have to be a closed area (e.g. like IT8.7/3). 
Single strips can also be combined to form one mask. Masks are not recurrent and cannot be 
used for ink control but for printing process control.

Use color control strips for ink control

You can select which of the available color control strips will be used for ink control. Only one color 
control strip may be used for ink control. The color control strip used for ink control is marked with 
the control icon. Disabled color control strips are identified with a red bar surrounded by a circle.

Only color control strips are used for ink control. Control blocks and masks, if they are present and 
detected, are evaluated only for checking and documenting quality in the Quality Monitor. For that 
reason, these elements always appear disabled (= red bar surrounded by a circle) in the "Control" 
column and cannot be enabled.
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1. In the list, mark the color control strip that will be used (or not used) for ink control.

2. Press the "Use control element for control" button.

The selected color control strip is enabled or disabled.

3. To enable a disabled element again for ink control, select that item in the list once more and 
press the "Use control element for control" button again.

Note: You can enable only one color control strip for ink control. 

Delete control elements

1. In the list, mark the control element you wish to remove.

2. Press the "Delete element" button. 

The control element is removed from the list after you confirm the alert message.

Details about the Control Element

You can use the Info button to display a dialog with details about the color control strips found.

�

�
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The top list shows the color control strips that were found. The results relating to the color control 
strip selected above display in the lower list, sorted by the degree to which they match. 

In a job with PPF, only the color control strip specified in the PPF always displays. In the case of jobs 
without PPF where the system browses the whole list of locally used color control strips, all color 
control strips whose result is above a certain limit display. The color control strip that matches best 
is always used.

Normally, the match for the suitable color control strip is 100%. If there is no 100% match because, 
for example, the sheet is damaged at one spot or no reference value was assigned to a color by mis-
take, the comparison shown in the lower section can help you locate the error.

The top row displays the scanned color control strip (top list) and the selected assignment result dis-
plays below that (lower list). If you briefly tap the diagram on the left or right, the display of the color 
control strips moves four patches to the left or right. When you keep your finger pressed down, the 
display moves until you let go or the end of the strip is reached.

In this way, you can compare the single patches of the color control strip and determine where there 
is an error. Patches that do not match are tagged by a red question mark ("?").
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Display of scanned image

You can use the top three buttons to change the display of the scanned image in order to look at cer-
tain sections more closely.

• When you press the magnifier button, the area around the active (flashing) control element is 
scaled up (+) or down again (-) in five steps.

You can move the full or scaled-up scanned image as desired within the display (keep your finger 
pressed on the touch screen during this action).

• The full scanned image displays again and is centered when you press the "Show preview 
image" button on the right.

Assign control elements manually

You can assign a control element manually if automatic detection does not find one or recognizes a 
wrong type. You can assign another type to existing control elements or assign additionally printed 
but not automatically detected control elements. 

Used color control strips are incorporated into color control, and the measured data are output in the 
"Overview" window and displayed in the Quality Report.

1. Press this button to assign measuring elements manually.

Next to the button, the buttons for assigning appear:

2. Select the type of control element with the buttons.

The list then displays only those control elements that match the selected type of control ele-
ment, in other words, for example, only the available color control strips:
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• (1) Control strip list (e.g. 4GS, Fogra4, recurrent) for control and export of measured data

• (2) Control block list (single-line minispots, not recurrent) only for export of measured data but 
not for control

• (3) Mask (test chart) list (double-line or multi-line minispots, not recurrent) only for export of 
measured data but not for control

3. Press the arrow button to open the list box with all available types of this control element.

Note: Only the color elements (e.g. color control strips) that are in the "Measuring Elements 
Used" list in "Service > Measuring device settings > Measuring elements" are listed. To 
speed up the search for color control strips, the list should only contain the elements that 
you actually use.

4. Select the type of measuring element you want from this list.

5. Indicate the measuring element you want in the scanned image by positioning the selection tool 
there:

• With color control strips, indicate any point on the control strip.

• With minispots, indicate the middle of the element.

�

�
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• An existing control element is overwritten by a new type if you indicate a point that is already 
detected as a control element (flashing area).

• A new control element is created if you indicate a point that is not yet defined as a control ele-
ment.

6. Press the "Assign" button after you position the selection tool.

The new control element is written to the list if the set element is found at the position indicated. 
An error message will be issued if the set element is not found at this position.

You can also press the button "Search sheet" after having selected the kind and the type of the 
measuring element: Prinect Image Control will then search the entire sheet for this measuring 
element. Here, you can search for several identical measuring elements. This is particularly use-
ful if the sheet contains several mini spots of the same type.
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Measure/Controls
Information about the "Measure/Controls" Work-
space

You go to the "Measure/Controls" workspace by pressing this icon in the header. This requires that 
the currently loaded job is released. Prinect Image Control automatically goes to "Measure/Controls" 
when a job is released in job preparation.

Navigation Bar 

You use the navigation bar on the right for most operations and for switching between the single win-
dows/workspaces. Tabs with various functions display below the header. These functions vary 
according to what you selected in the navigation bar. You can access the following operation areas 
using this navigation bar and the tabs:

• Overview: Display of zonal inking deviations or measured values of the color measuring system 
and Quality Report to check the print quality and to comply with the selected process standards

• Reference values: Display of the reference values for viewing, selecting and editing them

• Measuring range: Display of the printed sheet to select or define measuring elements or areas 
for image measurement; see also Measuring range > Homogeneous Areas and Measuring range 
> Image Areas and "Measuring range > Color analysis", page 159 (only in the PPF workflow).
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You can use the three buttons in the lower part of the bar to trigger a new scan, switch to the "Manual 
mode", lock single zones or send the data to the press for color control. 

If you have jobs with printing on the front and back, you can toggle between the two job parts using 
the buttons above the navigation bar on the right.

The functions that are performed by pressing the buttons in the navigation bar are described below:

Toggle between front and back

For jobs with printing on the back, there are two surfaces for which color control must be operated 
separately. However, you can measure and display only one surface at a time. Use these buttons to 
toggle between the font and the back.  
The button for the back (left) is disabled in jobs that do not have printing on the back.

Invoke the operation areas 

In "Measure/Controls" you can switch between the following operation areas using these buttons:

• Overview

• Reference values

• Measuring range
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Start/stop measurement 

Measurement is started with the "Measure" button. The "Measure" button then changes to a "Cancel" 
button. During measurement, the forward and reverse scan display in the image preview (if enabled) 
and as a thumbnail in the footer.

The measurement currently running is canceled if you press the "Cancel" button during the scan or 
calculation. Existing measured values are deleted after you cancel a measurement.

Manual mode 

You can switch to manual operation of the ink zones by pressing the "Manual mode" button. The 
manual mode is available only in the "Overview" operation area; the button is disabled in the other 
operation areas.

You can cut off (lock) single zones from ink follow-up in the manual mode (see Lock/unlock ink 
zones). 

The "Measure" and "Run control" buttons in the navigation bar are disabled while the "Manual mode" 
button is enabled. They can be selected again only after pressing the "Manual mode" button again.

Run control 

The currently set controlled variables are sent to the press by means of the "Run control" button. Run-
ning the control is available only in the "Overview" operation area; the button is disabled in the other 
operation areas. You must have selected at least one printing unit/one color for control. The button 
is disabled if this is not the case.
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Controls / Displays in All the Windows 

Select or Deselect Colors/Printing Units

Each button on the left of the window shows the color concerned (as a color bar), the color code and 
the printing unit number. Printing units that are not assigned a color are displayed with a gray bar 
and no color code.

As many as eight colors or printing units (no coating units) are displayed. You can scroll between the 
displays if you have more than eight colors.

Note: When perfecting is enabled, printing of the back starts only with the first printing unit 
for perfecting. This color starts in the very top row.

• Color buttons: You select a printing unit so that you can modify the zonal reference values by 
pressing a color button.

Buttons with a white background show printing units enabled for ink control.

• Sum button: You can select or deselect all the colors at one go using the sum button. You can 
select or deselect a single printing unit again if you press a color button afterwards.

�

�
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Status of the Ink Zones 

• Locked ink zones are marked by a red "x" (see Lock/unlock ink zones for details about unlocking 
zones).

• Ink zones that lie beyond the sheet (table) appear dark gray. A zone is on the sheet if parts of it 
cover the sheet.

• Ink zones that are on the sheet but do not have any content (unprinted sheet edge) appear light 
gray (see the two outer zones in the example shown).

• Ink zones tagged by an exclamation point in a yellow circle (only with PPF jobs) have data about 
image control that is not used because strip control is active and there are no color control strip 
data in this zone (e.g. for tags printed on the sheet edge; see the outer zones for black in the 
example shown).

• A zone is red if it is not a PPF job and if there are data for control for some colors in the zone 
but not for others (occurs mainly on the edge of the color control strip).

• A wrong sheet was loaded or there are no reference values if all ink zones have a red back-
ground.

• An ink zone with a yellow border indicates that one of the warning limits for ΔE, Best, S/D or 
paper white monitoring (set in the "Service" workspace) or for dot gain (taken from the process 
standard) is exceeded. The corresponding value has a yellow background in the data table (see 
section "Warning limits", page 173).
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Show Press Sheet Preview 

You can show a preview of the scanned sheet parallel to the bar graph (inking display) by pressing 
the "Image display" button. The bar graph is squeezed together in this process and the scanned 
image displays in the upper part of the window. The sheet preview is hidden again when you press 
the "Show image" button again.

Note: In the data table, only the middle value for dot gain displays if the scanned image is 
shown.

�

�
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When the scanned image displays, you can select whether to display the image compressed, that is, 
it will be fit to the window size or whether to display it as it is. When you display it as it is, a slider 
appears beside the buttons that you can use to move the image within the window. The "Zones" but-
ton lets you display grid lines that show the position of the ink zones on the scanned image. You can 
hide these zones again by pressing the button once again.

You can set the image view differently for each operation area. The setting is kept when you go to a 
different operation area. This means that when you show the scanned image again, it displays as was 
last set for this operation area.
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Overview 
The overview displays the zonal inking deviations or the data of the color measurement system

Overview > Inking 

1. Press the "Measure/Controls" button in the header.

2. Press the "Overview" button in the navigation bar.

In the "Inking" tab, you view the inking deviation (deviation between the measured actual value and 
the reference value defined beforehand) for each color in the various zones. You can select or dese-
lect printing units for control and select single zones. The mean value of the selection you made (all 
the zones of a printing unit or single zones) displays in the tab. The mean or zone value has a yellow 
background if the warning limit for a measured value is exceeded. In other words, it is possible that 
the mean lies below the warning limit but single zones are marked because they deviate more notice-
ably.

You can show a preview of the scanned sheet parallel to the reference values displayed by pressing 
the "Show image" button (you can find details about this in Show Press Sheet Preview).
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Select and deselect zones 

1. To select: Mark a zone by pressing this zone or mark a range by dragging your finger across sev-
eral zones. The marked zone or range is highlighted by an orange background.

2. To deselect: Press the zone again. The selected zone displays without the orange background.

Inking display

Data table

The following values display for each color in the table:

• ΔF: Inking deviation in percent

This value corresponds to the bar graph.

• Z: Dot gain in percent for the dot area of a certain patch

The dot area results from the definition of the color control strip. As many as three dot areas can 
be shown one below the other. When the preview is shown, only one of the values for dot gain 
displays.

• ΔE: Correctable color difference (top row)

• Best: Non-correctable color difference (value shown in gray in the bottom row)

The non-correctable color difference is the smallest color difference possible between the 
selected reference value and the ink/printing material used.
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The following applies for all the values: When a certain zone is selected, the value for this zone dis-
plays. The mean of all the zones displays if no zones are selected. Locked zones or zones with no 
measured data are ignored. Values are highlighted in yellow if they are out of the tolerances set in the 
process standard or are above the warning limits set in "Service".

There are warning limits for ΔE, Best, S/D (slurring/doubling) and for paper white monitoring. You 
can set these warning limits in "Service > Measuring device settings > Basic settings". The values 
have a yellow background if a warning limit is exceeded. You can disable each warning limit sepa-
rately (see Warning limits, page 173).

In addition, there are yellow warnings for the values of dot gain. You cannot modify these warning 
limits. They are taken from the currently set process standard. However, you can fully disable the dot 
gain warnings.

Bar graph in the zone display

The middle line in the ink zone display represents the set reference value. The bars show the devia-
tion between the actual value and the reference value in % ΔF.

The bar graph is modified in steps of 1%. A dividing line appears between the bars for each color devi-
ation of 5%. A color deviation of more than 15% is indicated by a triangle. In this example, the zones 
show color deviations of -7%, -12% and more than 15% (from left to right). Zones with image content 
that are not controlled are tagged by a yellow circle with an exclamation point.

Paper white monitoring

Below the table of values, the symbol and the difference (compared to the previous measurement) 
for paper white monitoring as well as the current Lab measuring values display:

selected zone

Data table

Warning limit for Best for 
the selected zone 
exceededZones in which a warn-

ing limit for the color 
was exceeded

Zone with image content 
that is not controlled
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Paper white is measured on every sheet and compared with the paper white of the last measurement. 

The difference in ΔE always displays. If the difference exceeds the warning limit for paper white, then 
the difference is highlighted by a yellow background. In addition, there is an info message in the 
warnings display.

To set the warning limits, see "Warning limits", page 173.

If you change the production run paper during printing, the deviation in paper white can be so great 
that color reproduction is affected too much and you may have to readjust the value.

Paper white monitoring always refers to the last sheet measured and consequently the warning in the 
"Paper white monitoring" box normally disappears after the scan of the next sheet. The info message 
in the warnings display, however, remains (info icon in the header in the "Malfunction/Service" but-
ton).

Lock/unlock ink zones 

You can cut off (lock) single zones from ink follow-up and unlock them again.

Prerequisite: You are in the "Measure/Controls" workspace and "Overview" is selected in 
the navigation bar.

1. Press the "Manual mode" button.

The "Lock" and "Unlock" buttons display.

Note: The "Lock" and "Unlock" buttons display in the "Inking" tab as well as in the "Mea-
sured values" tab.

To lock ink zones

2. Use the color or sum button to select the printing units on which single ink zones will be locked.

3. Mark one or more zones.

�

�
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4. Press the "Lock" button. The locked zones are indicated by a red "x".

Example for locked ink zones

In this example, all of zone 12 is locked (1). This means that zone 12 and all five color buttons were 
selected when you pressed the "Lock" button. In zone 09 only magenta is locked. In other words, 
zone 09 and only the "M2" button (2) were selected when you pressed the "Lock" button.

To unlock ink zones

5. Use the color or sum button to select the printing units on which locked ink zones will be 
unlocked.

6. Mark the zone(s).
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7. Press the "Unlock" button. The red "x" indicating the lock is removed from the zones and the 
zones are released again for ink follow-up.

Note: After locking or unlocking zones, you must press the "Manual mode" button again to 
enable the other elements in the navigation bar again..

Release ink follow-up

After the data are measured, the measurement results and the inking deviations are calculated; they 
can now be sent to the press.

Prerequisite: At least one printing unit must be selected and you must be in the "Overview" 
operation area. Only then can you select the "Run control" button and release ink follow-up.

1. Press the "Run control" button.

Ink follow-up is released. The measurement results and inking deviations are sent to the press 
separately for each printing unit.

�

�
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Overview > Export Image Inspection Data 

Prerequisite: To use this function, the "Offline Inspection" license must be enabled and a 
hotfolder set up as "Inspection Output folder" in "Service > Integration/System > Prinect 
Configuration".

When you press this button, Prinect Image Control buffers the data of the last sheet scan present in 
the BME and then writes the data (200 dpi image data and an .xml file with descriptions) to the net-
work folder set up as hotfolder. The PDF inspection system will then evaluate this data by comparing 
it with a reference PDF. Prinect Image Control also lets you analyze press sheets printed on presses 
without integrated camera with the PDF inspection system.

While Prinect Image Control is writing data from the buffer to the hotfolder, you can continue working 
in the "Measure/Controls" area or even start scanning another sheet. Operation of Image Control is 
blocked only while the data are imported from the BME.

Exporting image data is not possible if a sample or proof scan was performed last; it is only possible 
on a sheet scan basis.

A dialog with a progress bar appears while the data is being imported to the buffer when you press 
the button "Image inspection data". Canceling the process will delete the buffer contents and data 
transfer to the hotfolder is not started.

When buffering is complete, the dialog closes automatically and the message "Data transmission" 
appears next to the button "Cancel", indicating that data transfer from the buffer to the hotfolder is 
in progress. Data transfer is complete when the "Cancel" button changes to the "Image inspection 
data (with checkmark)" button.

When you cancel the data transfer from the Image Control buffer to the hotfolder, the data in the buf-
fer and also the data already written to the hotfolder will be deleted to prevent creating incomplete 
data sets.
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Overview > Measured values 

1. Press the "Measure/Controls" button in the header.

2. Press the "Overview" button in the navigation bar.

3. Select the "Measured values" tab.

The bars show the density that is measured in the single zones. You can use the list box to select the 
measured variable that is shown in the bar graph. The data table shows the values for all available 
measured values (D = density, S/D = shifting/doubling, Z = dot gain). The icon and the difference for 
paper white monitoring display below the data table (see Paper white monitoring, page 112).

The type of filter is indicated for density: D(M3) = polarized, D(M1)/D(M2) = non-polarized. The type 
of filter is set in the "Service" workspace in "Measuring device settings > Measuring conditions". Non-
polarized density is always specified if measurement is controlled via image areas and not color con-
trol strips.

Note: You must first position the single measuring head manually in order for the density to 
display after the first measure run. If the position is not yet known during the first scan, the 
position of the control strip is determined automatically from the image after the first scan 
and the single measuring head is positioned automatically for the next scan. These values 
are then available only after the second measure run.

�
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You can show a preview of the scanned sheet parallel to the reference values displayed by pressing 
the "Show image" button (you can find details about this in Show Press Sheet Preview). If a scanned 
image displays, the pipette button (1) also displays below the measured data. You can move the color 
data tool (2) on the scanned image and view the Lab values for the selected area (3) when you press 
this button.
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Overview > Quality Report 

The Quality Report that is integrated in Prinect Image Control monitors the printing process. Different 
procedures let you check and record the quality of this process in a systematic and simple manner. 

The measured data required for this are recorded using defined test equipment. The spectrophoto-
metric measurements obtained with Prinect Image Control are available for simple and direct use. 

The quality assessments are based on the color data sets of defined test charts and test strips (e.g. 
ISO 12642/ANSI IT8.7, ECI 2002, CGATS, HDM, Ugra/FOGRA) and on a comparison of these with 
stored standards or standards you defined. 

Control strips in the printable but non-usable area are also printed during output on a press. The 
strips are then measured and compared with the process defaults. This lets you check whether the 
printing process complies with the process standard (see the notes on the process standard).

The Quality Report lets you record and check colors and dot gains.

Comparing color data sets, Quality Report calculates quality variables such as statistical parameters. 
The results are shown in easily understandable tables and charts. This lets you create quality reports, 
for example, as are required for certified businesses.

Controls

You can use these buttons to view the following in the bar chart:

• Dot gain

• Ink trapping values (overprint patches C+M, C+Y, M+Y)
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• Slurring/Doubling

• ΔEo or Best (so-called non-correctable color difference, i.e the difference between target value 
and maximally obtainable color value, calculated with different formulas)

Pressing the sum button displays all views. The graphics or values display on those zones they were 
measured in.

Green indicates that tolerances are met, red that they are exceeded.

The dot gains for quarter, half and three-quarter tone display in the middle or on the right of the 
zones.

Press this button to show/hide a pop up on the right indicating the value range. For each ink, the 
measured dot gain values for the respective screen range display as curves.

When you mark a zone in the bar chart, only the measured values of this zone will display. Deselect-
ing this zone will display the median of all zones again.

Reference values and tolerances refer to the selected process standard.
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The caption displays the process standard used for assessment. 

You can toggle the zones the pop up is to show with this button. By default, the pop up displays to 
the right of the bar chart. When you mark a zone, this function will automatically place the pop up 
next to the selected zone for easier direct comparison.

Use this button to assign a different reference color of the process standard to each of the inks.

Note: More detailed analyses and quality assessments are possible when you use the 
Prinect Image Control connection in Color Toolbox.

�
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Reference values
You can select, view and edit reference values and create a color set in the reference value overview.

Reference values > Modify 

1. Press the "Measure/Controls" button in the header.

2. Press the "Reference values" button in the navigation bar.

3. If necessary, select the "Modify" tab.

The currently set reference values or their deviations display for each ink zone and you can modify 
them. The values show the sum of all changes to the reference values. For example, the display 
shows +15% if the reference value was first increased by 10% and then once again by 5%. An OK 
sheet that was defined is marked by a tick. The changes to the values are retained.

The source of any changes made can be seen in the ink zones:

• Changes made through a "Zonal Match" or with the "Change by percentage" button in the "Mod-
ify" tab display as plus/minus values (1).

• Changes made through "OK Areas > OK sheet" are indicated by a checkmark (2).

• Changes made through "OK Areas > OK color control strip" are marked by a BCMY symbol (3).
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The data table displays the following values:

• Δ%: Change in percent (in relation to the reference value) as the mean for all marked or 
selected zones.

• D: Current density reference value as specified in the color set

• D*: The additional column in the data table specifies the expected color density with the new 
reference values.

Select and deselect zones

1. To select: Mark a zone by pressing this zone or mark a range by dragging your finger across sev-
eral zones. The marked zone or range is highlighted by an orange background.

2. To deselect: Mark the zone or range again. The selected zone or range displays without the 
orange background.
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Controls in "Reference values > Modify"

You can show a preview of the scanned sheet parallel to the reference values displayed by pressing 
the "Show image" button (you can find details about this in Show Press Sheet Preview).

The following buttons are available only if at least one ink zone and one color button are selected.

• Modify reference values by a percentage factor: Modifies the selected reference values in 
steps of 1% each (see Assign reference values (change in percent)).

• Reset changes to reference values: Resets all the reference values back to 0% (see Reset 
changes to reference values).

• OK: The OK button is enabled whenever changes to the reference values of the selected colors/
zones are made. The currently set changes are applied only after you press the OK button.

• Cancel: If you press "Cancel" instead of OK, all changes that were not yet applied by pressing 
the OK button are discarded and your initial situation is restored.
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Assign reference values (change in percent)

This function lets you change the reference values of all the zones or of a selected zonal range by a 
percentage factor.

1. Select the printing units (by pressing the color button) and zones you want You can select all the 
printing units at one go by pressing the sum button.

2. Set the changes you want using the +/- buttons.

The value is changed by 1% each time you press the button. The current percentage of the 
change you made displays in the box beside the two buttons.

The changes to the percentages are applied only when you press the OK button.

Note: When the set values are applied to the ink zones, the conversion can cause the ref-
erence value to change again.

Reset changes to reference values

This lets you discard the change you made to the reference values for all zones or a selected zonal 
range. This means that you can set the modification value to 0%, irrespective of how the change to 
the reference value came about.

1. If necessary, deselect the printing units (by pressing the relevant color button) and zones whose 
reference values are not to be reset. You can deselect all the printing units at one go by pressing 
the sum button.

2. Press the "Reset" button. The changes to reference values of all the marked zones are set to '0'.

You apply the reset when you press the OK button.

�
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Reference values > Select 

The reference values filed in the color sets are based on measured spectral color data. The reference 
values are selected back in job preparation but you can select different ones at this point for all the 
colors or certain ones.

The color set you select depends on the inks actually used in the printing units. Consequently, you 
can in principle select reference values from another color set for each single color. You are not com-
pelled to select all the colors from the same color set.

Functions and operation in the "Select" tab are the same as in the Reference values step in job prepa-
ration.

In the "Reference values > Select" window, you can assign reference values to the printing units of 
the press, measure a color sample and save the currently used colors to a color set.

• You display the "Assign setpoints" window by pressing one of the boxes in the "Color set" col-
umn (see section ""Assign setpoints" window", page 78).

• You display the "Lab input" window by pressing one of the boxes in the "Reference values" col-
umn. You can enter the desired Lab values directly in this window (see section ""Lab input" win-
dow", page 79).

With the color picker, you can measure color samples. Operation is like measuring a "Reference value 
from sheet" with sheet change (see ""Color measuring" (reference values from sheet) window", page 
81).
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You can save the colors you selected in a color set like in Job preparation (see "Saving a Color Set", 
page 86).
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Reference values > OK Areas 

1. Press the "Measure/Controls" button in the header.

2. Press the "Reference values" button in the navigation bar.

3. Select the "OK Areas" tab.

Like in the overview, the current controlled variables display together with the measured sheet.

The "OK sheet" and "OK color control strip" buttons are enabled when you select one or more color 
buttons. The whole zonal range must always be enabled, if not the "OK sheet" and "OK color control 
strip" buttons are disabled.

• OK sheet: Enable the "OK sheet" button if you wish to use the measured data of a measured OK 
sheet. The current actual values of the OK sheet are used as the new reference values when you 
do this. Like a manual change, this only concerns a zonal change to the reference value. In other 
words, the actual reference value for the color is kept but an offset is added to or subtracted 
from the value. The zones are check-marked.

The "OK color control strip" function runs automatically together with "OK sheet" and conse-
quently all the homogeneous areas are also controlled accordingly.
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• OK color control strip: Enable the "OK color control strip" button if you defined color control 
strips and wish to use their OK status. The measured data of the color control strip are used as 
the new reference values when you do this. Like a manual change, this only concerns a zonal 
change to the reference value. In other words, the actual reference value for the color is kept but 
an offset is added to or subtracted from the value. Homogeneous areas are also controlled 
accordingly.

• Disable image control areas: The button is enabled only if the "OK sheet" or "OK color control 
strip" functions were run beforehand. All the defined homogeneous areas and also the OK sheet 
are disabled. Only the OK color control strip is controlled.

Tagging of zones: "OK color control strip" = open BCMY icon (see top row), image areas excluded from 
control = closed BCMY icon (see bottom row).

Display of the controlled OK areas in the scanned image

red hatch OK color control strip

blue hatch Homogeneous areas that are also controlled

yellow hatch OK image areas (only with "OK sheet")
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Reference values > Zonal Match 

1. Press the "Measure/Controls" button in the header.

2. Press the "Reference values" button in the navigation bar.

3. Select the "Zonal Match" tab.

When the "Zonal Match" tab displays for the first time, you will first see a view without an image. You 
can choose between viewing the inking and the measured values (densities).

The results of "Zonal Match" are written immediately to the inking graph. You must apply or discard 
any changes you made before going to another tab or menu. An error message will be issued if you 
do not do this.

Controls in "Reference values > Zonal Match"

• Determine reference values: New reference values are determined from the color control strip 
data (available only if an ink zone and a color button are selected). 
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• Apply reference values: The new reference values are applied to one or more different zones.

• Undo: The reference values that were applied are undone step by step.

• Save Ink Set: You can save the new reference values as a new color set in the color database 
(see "Saving a Color Set", page 86 for a description).

Note: "Save Ink Set" is available only if at least one measuring element with single measur-
ing head data (color control strip) is active.

• View image: The "View image" button lets you also show a preview of the scanned sheet like in 
the "Modify" tab (more details can be found in Show Press Sheet Preview). It is then not possible 
to switch between "Inking" and "Measured values".

• Select all zones: This button is for easier operation. It selects all zones. Use this to "determine 
reference values" or also to "transfer reference values".

�
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• OK: The OK button is enabled whenever changes to the reference values of the selected colors/
zones are made. The currently set changes are applied only after you press the OK button and 
can no longer be revoked with the "Undo" button.

• Cancel: If you press "Cancel" instead of OK, all changes that were not yet applied by pressing 
the OK button are discarded and your initial situation is restored.
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Record new reference values

1. Select one or more color buttons (sum button = all color buttons are selected; you can then 
deselect single colors). In the example shown: 3 (cyan) and 4 (magenta)

2. Select one or more source zones from which the new reference values are to be determined (in 
the example shown: zones 06 thru 10).

3. Press the "Determine reference values" button. The new reference values are recorded and the 
zones highlighted by an orange frame and green background. The reference value of a color is 
determined using the color control strip data of the selected zones of this color.
Prinect Image Control  –  User’s Guide 133



Measure/Controls
Apply new reference values to zones

The "Apply reference values" button is enabled when new reference values were recorded and you 
can apply the new values to one or more zones. You may not change your selection of color buttons 
now, otherwise you must determine the reference values again.

1. Select the zones to which the reference values will be applied.

2. Press the "Apply reference values" button. The reference values are applied to the selected 
zones and the inking deviation is immediately recalculated.

Like the source zones, the zones to which values were applied are highlighted by a checkmark. The 
source zones remain selected and can be applied to other zones.
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Changes made through "Zonal Match" affect color strip control only and do not affect the parts of the 
inking graph that result through image areas and homogeneous areas. They act like changes in per-
cent and display in the "Modify" tab as plus or minus values in the zones.
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Reference values > Color set

Note: The "Color set" tab is available only if one measuring element with single measuring 
head data (color control strip) is active.

1. Press the "Measure/Controls" button in the header.

2. Press the "Reference values" button in the navigation bar.

3. Select the "Color set" tab.

When the "Color set" tab displays for the first time, you will first see a view without an image. You 
can choose between viewing the inking and the measured values (densities).

The zone with the slightest absolute deviation from the selected reference value is marked for each 
color. Based on this, you can either create a new color set or overwrite the values of an existing color 
set with the current values.

• Save Ink Set: You can save the marked reference values as a new color set in the color data-
base (see "Saving a Color Set", page 86 for a description). Only colors where at least one zone 
is selected are included in this process.

�
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For example, you can deselect all colors but one, press the button with the pipette icon and then 
press the marked zone of the active color. The zone is disabled, and then no reference values for 
this color for saving to a color set are available.

However, you can also enable other or additional zones for this color, creating a mean of all 
active zones by doing so.

• View image: The "View image" button lets you also show a preview of the scanned sheet like in 
the "Modify" tab (more details can be found in Show Press Sheet Preview). It is then not possible 
to switch between "Inking" and "Measured values".

Select all zones: This button is for easier operation. It selects all zones. In this case, a mean of all 
the zones is created for the selected color.

Select marked zones: This tool lets you select the currently marked zones and used them for creat-
ing the mean. When you press the button again, all currently marked, enabled zones are deselected. 
In this way, you can, for example, disable the suggested zone for a color or add more zones to it. The 
mean is then created from all enabled zones.
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Example:

In the example shown, Prinect Image Control determined and marked zones 14 (for yellow), 09 
(magenta) and 11 (spot color) as areas with the least deviations.

If you now enable magenta and cyan (3) and select zones 07-09 (2; highlighted in orange), the fol-
lowing happens when you press the pipette button:

• For cyan, zones 07-09 are marked and the mean of these zones is calculated.

• There are no changes for the spot color, black and yellow.

• For magenta, zone 09 (determined automatically) is disabled (1), zones 07 and 08 selected and 
the mean determined from 07 and 08.
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Measuring range
In Measuring range, you can select the control elements used or define areas for image measure-
ment.

Measuring range > Measuring elements

Functions and operation in the "Measuring elements" tab are the same as in the "Measuring ele-
ments" step in job preparation. In this workspace, you can define color control strips and enable or 
disable them for control without having to go to job preparation again. See section "Measuring ele-
ments", page 95.

Measuring range > Homogeneous Areas

Note: The "Homogeneous Areas" tab is available only in the PPF workflow. �
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In "Homogeneous Areas" you can define two different settings:

• The solid tints of the printing units (process colors and spot colors) display below the scanned 
image. These colors are used automatically for solid tint image control. When you select a color, 
this flashes white. All homogeneous colors flash white if you select all the colors using the sum 
button.

You can enable or disable a selected printing unit color for solid tint image control by pressing 
this button. However, you cannot delete it.

• Screened colors can be made up of as many as four printing unit colors printed on top of one 
another.
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When the "Homogeneous Areas" tab displays, the printing unit colors shown below the image are not 
selected to start with.

You can enable and disable the image control for the solid tint areas of the printing unit colors. To do 
so, you can select or deselect all the colors at one go using the sum button. A printing unit color root 
can not be deleted.

Display of scanned image

You can use the top three buttons to change the display of the scanned image in order to look at cer-
tain sections more closely. When you press the magnifier button, the area around the center of the 
scanned image or the crosshair is scaled up (+) or down again (-) in five steps. You can move the full 
or scaled-up scanned image as desired within the display (keep your finger pressed on the touch 
screen during this action). The full scanned image displays again and is centered when you press the 
"Show preview image" button on the right.
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Create areas with homogeneous colors (screened colors)

This button lets you look for screened colors and define them as homogeneous screened colors (1). 
The buttons for looking for and defining colors appear in the lower part of the window when you press 
the button.

1. Press the "Define homogeneous screened colors" button (1).

2. Then press the pipette button (2).

3. Position the color data tool (3) at a point in the scanned image where the color is located. If nec-
essary, use the magnifier buttons to scale up or scale down the scanned image.

The Lab values and a color patch display to the right (4). All points in the image with identical 
color data flash.

4. If necessary, move the color data tool until the area you want starts to flash.

5. Press the "Assign" button (6).

The new homogeneous color now displays below the scanned image, showing a patch, an icon 
for screened colors and the Lab values at this position in the image (7).

The tag on the right of the patch indicates that this color is a homogeneous screened color.
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Arrows appear on the sides if you created more than five homogeneous colors or printing unit colors. 
You can use these arrow buttons to move the visible part of the patches.

6. Press the "Color archive" button (8) if you wish to copy the homogeneous color to the color 
archive. A dialog then opens where you can select the color set to which you want to assign the 
homogeneous color. You can also rename the color there. By default, the color name is gener-
ated from the Lab values.

Reference value of the homogeneous screened color

Option 1: Measure the reference value of a homogeneous screened color in the image

The Lab value measured at the position of the color data tool in the image is used as the reference 
value (see above for procedure).

Option 2: Assign a reference value of a homogeneous screened color from the color database

After you defined a screened homogeneous color, you can assign it a reference value from the color 
database. Image control tries to reach the specified reference value for this homogeneous color.

1. Press the "Load color" button to open the "Select Color" window.

2. Select a color set and then a color from there.
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3. Press the OK button to load this color as a homogeneous color to the current job.

The new homogeneous color now displays below the scanned image, showing a color box, an 
icon for screened colors and the color name.

Enable/disable homogeneous screened colors

The selected homogeneous color is disabled or enabled again after you press this button for image 
control.
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Sum button: You can select or deselect all the colors at one go using the sum button.

Delete areas with homogeneous colors

The selected homogeneous color is removed after you press this button and confirm an alert mes-
sage. The assigned image areas will be handled as process colors during ink control.

Note: Deletion of homogeneous colors is possible only for screened colors. You cannot 
delete printing unit colors.

�
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Measuring range > Image Areas

Note: The "Image Areas" tab is available only in the PPF workflow. 

Color is controlled

• via a selected color control strip and/or

• via image control in homogeneous areas and/or

• as image control if an OK sheet was defined and/or

• via 1ups (see "Define Image Areas > 1Ups", page 149).

This is where you can exclude sections from control by disabling the parts concerned in the scanned 
image using a selection tool. Vice versa, this is where you release locked sections again.

In the scanned image, all the image areas involved in the control display with their set color. All other 
areas that are not controlled have a white mask.

�

�
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Display of scanned image

You can use the top three buttons to change the display of the scanned image in order to look at cer-
tain sections more closely.

• When you press the magnifier button, the area around the center of the scanned image or the 
frame tool is scaled up (+) or down again (-) in five steps.

You can move the full or scaled-up scanned image as desired within the display (keep your finger 
pressed on the touch screen during this action).

• The full scanned image displays again and is centered when you press the "Show preview 
image" button on the right.

Lock image areas

1. Press the "Lock image areas" button.

Three other buttons display:

• Lock selected area

• Unlock selected area

• Unlock all
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A red frame with two handles (1) appears in the scanned image.

2. Position the rectangular frame tool over the image area that you wish to exclude. If necessary, 
use the plus/minus buttons to scale up or down the image preview.

3. If necessary, use the two handles to make the area bigger or smaller so that the entire area you 
do not want will be covered with a red mask.

4. Press the "Lock area" button (3).

The marked area is set as the area you want to lock and shown with a red mask (2).

(5). When you position the frame tool fully or partially over a locked area, you can unlock the 
selected area by pressing the "Unlock" button (4). In this case, only the area covered by the 
frame tool is unlocked; the areas not covered by the frame tool stay locked. In the example 
shown above, in area (2) the part above and to the right of the frame tool would stay locked.

(6). If several areas are cut off from control, you can undo all locks at one go by pressing the "Unlock 
all" button (5).

7. Press the "Lock image areas" button again to quit the function.

The three buttons are hidden again.
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Define Image Areas > 1Ups

Press this button to enable the image control functions via 1ups.

Basically, there are three ways of controlling the image via 1ups:

• Matching the 1ups of a sheet: One or several areas are defined as reference in the measured 
sheet. Homogeneous areas in the other 1ups are controlled based on the value of the reference 
area.

• Loading of 1ups from the archive (only with "Proof Match" license): You can save 1ups defined 
for control in the 1up archive and import them from there for use with similar jobs later.

• Scanning of 1ups from the sample sheet (only with "Proof Match" license): A sample sheet is 
scanned with Image Control (e.g. an original packaging or a proof). This sample sheet need not 
be a complete sheet containing all 1ups but could be a single 1up or even part of it only.

Note: Please remember that proofs are printed on papers and inks differing from those used 
by the press when measuring a 1up originating from a proof. As a result, the calculated set-
points cannot always be reached. Make sure to check the deviations indicated in the Info 
window when you use this method.

�
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Definition of Terms

• 1up: 1up refers to the number of items of a print product located on a press sheet. To optimally 
utilize the space on the press sheet, several identical or different copies (such as labels, posters, 
packagings) are distributed over the available space. A 1up is always a combination of shape and 
associated inking information.

• Shape: The shape describes the shape of a 1up but does not contain any inking information. 

• 1up type: A 1up type comprises all 1ups on a sheet whose shape and inking are identical. 

• Reference 1up: The reference 1up is the 1up whose shape and inking are used as basis for con-
trolling the other 1ups of the same 1up type. This can be a 1up defined manually on the sheet, 
the 1up scanned from the sample sheet, or the 1up saved in the archive.

Functional principle

• Define an area on the sheet scan as the reference 1up by drawing a polygon mask. Once this 
mask has been applied, Prinect Image Control will automatically identify all identical areas on 
the sheet which are then controlled on the basis of the reference 1up.

• You can scan and control several 1ups of a print job (up to 16 1up types per page).

• You can easily define 1ups of the same shape but with different inking by making a copy of the 
shape and moving it to the other area. You can also rotate the shapes in steps of 90° in clock-
wise direction.

• It is not possible to control 1ups in locked image areas.

• A 1up type may be made up of a maximum of four colors printed one on top of the other. Solid 
tints are controlled regardless of that.

Defining a Reference 1Up

1. Press the "Submit 1up" button.

2. Press the "Define 1up manually" button.
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3. Place the selection tool in the scanned image on one corner of the area you want to define as 
reference 1up and press the button "Set point for shape".

4. Add more points in the same way until the desired area is enclosed.

5. To finish, press the button "Close shape and apply".

6. Press the "Find 1up" button. Prinect Image Control will now search the sheet scan for identical 
1ups and will apply the shape to these areas.

All the found areas will then be controlled on the basis of the selected reference 1up. These areas are 
identified with a green frame. The reference 1up is identified with a blue frame and the numbering 
with an asterisk.

Other 1up Editing Functions
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Delete point from shape: Press this button to delete the last point you defined in the current shape. 
You cannot delete points of submitted shapes.

Copy 1up: The shape of the selected 1up is copied and pasted as a new shape. You can move this 
shape on the scanned image without restrictions and rotate it in steps of 90°. Press "Find 1up" when 
the shape has been positioned. In this way, you can apply identical shapes to 1ups with different ink-
ing. This facilitates your work, in particular with more complex shapes.

Rotate shape: Press this button to rotate the currently selected shape by 90°; this can be particu-
larly useful for packaging printing. You cannot rotate submitted shapes.

Delete 1up: The frame around the selected 1up is deleted, the 1up is removed from the 1up type and 
will no longer be controlled on the basis of the reference 1up. The button "Delete 1up" is disabled if 
the reference 1up is selected.

Tag 1up as reference 1up: The selected 1up is defined as the new reference instead of the reference 
1up used so far.

List of defined 1ups

All the 1ups defined for this sheet scan are listed to the right of the scanned image. These can be 1ups 
defined manually ("Nutzen_*"), 1ups imported from a sample measurement ("Muster_*") or 1ups 
loaded form the archive that appear by the name that was used to file them in the archive.
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(1) Use 1up type for control: With this button, you can enable or disable control by way of the 1up 
type selected in the list box. Disabled 1up types are hatched in red in the scanned image.

A 1up type used for control is marked with a colored frame in addition to the control icon in the table. 
The color of the frame indicates how well the 1ups on the press sheet match the reference 1up after 
controlling has been completed.  
Deviations: ΔE 0 to 3 = green = low, ΔE 3 to 6 = yellow = medium, ΔE > 6 = red = high.

(2) Delete 1up type from table: The 1up type selected in the list is deleted without confirmation.

(3) 1up information: Opens a window with details about the defined 1up. This window lists all 
defined 1up types with scanned image, name and number of related 1ups and the position on the 
scanned image.

The reference 1up that comes from the sheet is blue. If no 1up is blue, the reference 1up comes from 
the 1up archive or the sample measurement.

With the Print button, you can save a report containing the above information as a PDF file in a (net-
work) folder.

Prerequisite: The 1up information is only available if the "Proof Match" license is enabled.
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1Up Archive 

Prerequisite: The "Proof Match" license must be installed to be able to use this function.

You operate the 1up archive with these buttons: With the left button, you load 1ups saved in the 
archive into the current sheet scan, with the right button, you file 1ups of the current sheet scan into 
the archive. With the middle button, you can determine the 1up of the proof.

With the archive, you can reuse 1ups for similar repeat jobs, which means that you need not create 
these 1up shapes from scratch for repeat jobs.

1ups loaded from the archive do not have a reference 1up in the sheet because they refer to the values 
saved in the archive.

Saving 1up to the archive

1. Press the "Save 1up to 1up database" button after you defined one or more 1ups in the scanned 
image. 

The "1up archive" window displays: To the left, you see the archive folder with all its subfolders. You 
cannot save 1ups directly in the 1up folder but only in job-related or customer-related subfolders you 
can set up with reference to jobs or customers, for example.
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The list to the right displays all 1up types defined in the current sheet.

(2). Use the button "New folder" to make a new folder if applicable.

3. Select the folder where you want to archive the 1up type.

4. Select the 1up type to archive in the list to the right.

5. Press the Edit button and type a name for the 1up type with the on-screen keyboard.

6. Press the arrow button: The selected 1up type is filed in the archive and can be loaded in similar 
jobs if needed.

7. Close the Archive window with the Close button at the bottom right.

Loading a 1up from the archive

1. Press the "Load 1up from 1up database" button. 
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The "1up Archive" window displays.

2. Open the desired folder and select the 1up type you want to load. A scanned image of the 1up 
type displays to the right of the folder tree.

3. Press the OK button.

The 1up type is transferred and Prinect Image Control immediately searches for matching 1ups in the 
current sheet scan.

1up from Sample Sheet 

Prerequisite: The "Proof Match" license must be installed to be able to use this function.

Note: Please remember that proofs are printed on papers and inks differing from those used 
by the press when measuring a 1up originating from a proof. As a result, the calculated set-
points cannot always be reached. Make sure to check the deviations indicated in the Info 
window when you use this method.

�
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1. Press the "1up from sample sheet" button.

2. Place the sample on the measuring table and press the Scan button in the "1up from sample 
measurement" window. All the other controls are enabled only when scanning is complete.

3. Like with the sheet scan, you can define one or several 1ups manually (see page 150). The cur-
rent shape is transferred to the list of "reference 1ups" when you press the button "Close shape 
and apply".

Like manually defined shapes, you can copy, rotate or delete them from the list.

4. Close the window with the OK button to transfer the 1ups defined in the sample scan. Prinect 
Image Control searches for suitable areas in the sheet and then controls these 1ups on the basis 
of the sample scan.

Note: When closing the window "1up from sample measurement" and opening it again, you 
must always perform a new sample scan, regardless of whether or not sample 1ups were 
transferred.

�

�
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Image Areas > Show Separations

A colored PPF image displays instead of the scanned image when you press this button. The table 
lists all separations. When you mark a separation in the list,  nly this separation will display as a gray 
image.

When you press this button as well, all pixels of this separation that are affected by the control flash 
red in the scanned image. Press this button again to switch off the flashing of the controlled pixels.

Measuring range > Color analysis 

With color analysis, Prinect Image Control as of version S19B_IC gives you the option of comparing 
any homogeneous colored areas with reference values.

This is particularly useful for multicolor printing because it is possible to check how well a spot color 
has been reproduced.
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Prerequisites:  

• "Mini Spot Plus" license

• PPF connection (otherwise only manual positioning is possible)

• The minispots must be 5x5 mm in size.

Operation

1. First, the job is set up completely with PPF data.

2. In the "Measuring range > Color analysis" tab, select the first reference color from the color 
archive (color master database or local archive).

This then displays in the list with the number 1 and the manual mode is activated. In addition, the 
cursor appears in the image.
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3. The OK button becomes operable when you hover the mouse pointer over a minispot or an 
image point of the reference color made of a multi color screen.

4. After you use the OK button, all similar minispots are automatically found and assigned. The 
image areas of the minispots have a green border and are assigned the number 1.

5. When you click a minispot with a green border, the Lab values of the minispot and the reference 
color as well as the ΔE distance display:
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6. Proceed in the same way with the other minispots and reference colors.

7. The Info button gives you an overview of the minispots of the colors selected in the list:
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The ΔE deviations with reference lines for each minispot display over the semi transparent measured 
image. The frame of the ΔE values corresponds to the reference color.

If the deviations are within the tolerance, they appear green, otherwise red.

The ΔE tolerance is set in the "Service" workspace in the "Basic settings" tab > "Warning limit ΔE" 
and applies to all colors.

Tip: In the list, you can select all colors by tapping the first item and dragging it to the last item with-
out setting it down.

You can use the Printer button to print a PDF to the set directory.

Alternative operation with automatic function

You can also search  for the minispots automatically. This is done by using the Automatic button.

The image is searched for homogeneous screen areas with the specified minispot geometry. The ref-
erence value of the minispots can be calculated based on the known screen composition and the 
assigned setpoints of the colors involved. In the color archive, the most suitable reference value is 
assigned from the shipped color fans (HKS, Pantone).

Using the "Change color" button, you can replace the suggested reference value with another refer-
ence value from the color archive.

Alternative operation with color control

You can define the minispots and/or the appropriate image areas as homogeneous halftone areas in 
"Measuring range > Homogeneous Areas > Halftone Areas" and assign reference values from the 
color archive (color master database or local archive).
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The minispots automatically appear in the "Color analysis" tab. Reference values are not assigned 
because they were already assigned in the "Homogeneous Areas" tab.

Alternative operation with manual function

In the manual mode, three modes are available for defining measuring points or minispots:

Define the image area as the measurement position

In this mode, you can define any image spot as measuring point with a rectangular frame. However, 
regardless of the size of the box, only the pixels (3x3) in the center of the box are evaluated.
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Add a single minispot

You can add a single minispot with this mode. To do this, the cursor is placed on the desired minispot. 
The system checks whether the color of the position in the image shown is not too different from the 
reference color and releases the OK button if necessary.

Add minispot (with automatic function)

This mode is identical with the operation described before when a new reference color is selected.
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Malfunction/Service > Messages and Device Malfunctions
Basic information about the "Malfunction/Service" 
Workspace

Press this icon in the header to open the "Malfunction/Service" workspace that is divided into two 
sections:

• Messages and Device Malfunctions: Display of program messages and malfunctions reported by 
the device

• Invoke "Service" Workspace: Grouping of various functions for management and settings of 
Prinect Image Control

Note: Some settings in Service can be invoked only if you have the permission to access 
them and cannot be seen or are dimmed during normal operation.

The "Malfunction/Service" workspace always opens displaying the "Messages" and "Device Malfunc-
tions" tabs when you press the "Malfunction/Service" icon.

�

�
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Messages and Device Malfunctions

Lists with general program messages and malfunctions reported by the device display in "Messages" 
and "Device Malfunctions".

• The messages that display are only for the selected active machine or job, e.g. "Wrong sheet", 
"Sheet too far to left" or "Color control strip not found".

• Malfunctions of the measuring device are always independent of the machine. The color tag 
indicates the impact of the malfunction on further operation:

· White circle with an i: Message for your information only (e.g. scan sheet does not match 
job or a press is offline). You can continue to work with Prinect Image Control.

· Yellow dot for malfunctions or errors that occur during day-to-day work and are easy to 
remedy. These are software or hardware errors. It is possible to continue working, but 
there are restrictions.

· A red dot indicates serious malfunctions in the measuring device. It is not possible to 
continue working. You must restart Prinect Image Control or request the assistance of a 
service technician.
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Note: The color tag also displays in the icon in the header, enabling a device malfunction to 
be detected even if a different workspace is open.

You can select a message or device malfunction in the list either by directly pressing the row con-
cerned or using the arrow buttons to scroll forwards or backwards row by row until you are at the 
message/device malfunction you want.

Buttons and their functions

Use the arrow buttons to scroll forwards or backwards row by row in the list.

Use this button to delete the message or device malfunction that you selected in the list.

This button lets you view more details about the message or device malfunction selected in the list. 
The details display in a dialog.

Use this button to close the information window again (e.g. "Warning" or "Details"). The current mes-
sage or device malfunction in the list remains selected.

�
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Press this button to invoke the "Service" workspace where various functions for management and 
setup of Prinect Image Control are grouped together. Some of these functions can be used only with 
special permissions.
170 S22A_IC



Malfunction/Service > "Service" Workspace

Malfunction/Service > "Service" Workspace
Invoke "Service" Workspace

You go to the "Service" workspace by pressing the wrench button in "Messages" and "Device Mal-
functions".

Navigation Bar

You use the navigation bar on the right for most operations and for switching between the single win-
dows/workspaces. Tabs with various functions display below the header. These functions vary 
according to what you selected in the navigation bar. You can access the following display and oper-
ation areas using this navigation bar and tabs:

• Measuring device settings: This is where you can shut down Image Control, enable or disable the 
mouse pointer, manage the color database, the process standards archive and (if "Proof Match" 
license is enabled) the 1up archive, select all the measuring elements that you wish to use, set 
measurement conditions and edit the list of saved jobs.

• Start-up/Press information: This section displays information about the hardware and software, 
the available licenses and the variant key. You can also set up the press configuration and open 
the integrated operating manual here.

• Integration/System: This is where you can connect Prinect Image Control to the Prinect Integra-
tion Manager/Prinect Pressroom Manager, set up a share directory for PDF files and define net-
work and locale settings such as the UI language.

• Remote Service: This is where the Heidelberg service can set up remote operation of Prinect 
Image Control.

• Diagnosis: This area offers direct operation and service functions. You can also set parameters 
for colorimetric checks, perform profiling and certification of the colorimeter.
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Measuring device settings
In "Measuring device settings", you can shut down Image Control, set and define measuring param-
eters and manage archives. The tabs give you access to the following sections:

• Basic settings: Enable/disable the mouse pointer, set warning limits and shut down the Image 
Control system computer.

• Color archive: Edit color sets and colors depending on the paper grade, measure new colors for 
the color database.

• 1up archive (only with "Proof Match" license): In the 1up archive, you can save 1up types defined 
for image control on a sheet scan and reuse these if needed.

• Measuring elements: Define which control elements will be used in Prinect Image Control.

• Process standards archive: Define the default process standards for the three paper grades and 
create and edit custom process standards.

• Measuring conditions: View and set the measuring conditions.

• Job list: Edit the list of saved jobs

Basic settings

Enable/disable mouse cursor

In the "Basic settings" tab, you can press "Mouse Cursor" to select whether you wish to operate 
Prinect Image Control solely using the touch screen or also using a connected mouse. This can be a 
good idea for more complex work, e.g. when defining a shape for a new 1up.
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After you press the button, a message displays, informing you that the Prinect Image Control system 
must be restarted after the mouse cursor is enabled or disabled, depending on what is currently set. 
When you quit the message with OK, the measuring system restarts and the setting for the mouse cur-
sor changes.

Warning limits

The values set in these boxes define as of when values in the data table in  "Measure/Controls" will 
have a yellow background and boxes in the zone display will be tagged by a yellow border. The warn-
ing limits have values by default, but you can change these individually if required.

You must enter values of >=99 in these boxes if the warnings are to be fully disabled.

You can set different warning limits for ΔE, Best+, S/D (slurring/doubling) and for paper white mon-
itoring. 

You cannot edit the warnings with a yellow background for the dot gain values because these are 
taken from the currently set process standard. However, you can disable dot gain warnings by press-
ing the "Dot gain" button (button is white = enabled, button is gray = disabled).

Shut Down System Computer

Use this button to shut down Prinect Image Control. The system computer shuts down in this process. 
We recommend that you shut down using the software rather than with the On/Off button because 
the system shuts down in a controlled manner and there is no risk of losing temporary data.

Warning: Danger! High Voltage! 
Prinect Image Control is not de-energized when you shut down using the software. Some 
components like the power supply modules are still live. If the device has to be de-energized 
for servicing, pull out the power connector after you shut down the device using the soft-
ware.

To switch on Prinect Image Control, briefly press the On/Off button on the right (see On/Off button, 
page 16).

Color archive 

In the "Color archive" tab, you can edit, create and delete color sets and colors and archive them in 
an easy-to-follow folder structure. 

Note: The descriptions below describe the procedures and display when working with a 
local color archive. Alternatively, you can also work with the central color master database 
if a MDS server is configured. See "Central Color Master Database", page 184 for details 
Some functions are only available when working with the local color archive.

1. Press the "Service / Malfunction" button in the header. 

2. Press the "Service" button (wrench icon). 

3. Press the "Measuring device settings" button in the navigation bar and select the "Color archive" 
tab. 

�
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The list displays all the color sets of a paper grade with the measured color data, color density and 
density filter. For a better overview, for example, if you have a great number of color sets, you can 
create a custom folder structure (e.g. sorted by customer) and file the color sets accordingly.

The color sets shipped with Prinect Image Control, for example, PANTONE©, HKS and ISO are always 
found on the top level. You can neither move nor delete them.

You can recognize the folders used in the structure by the well-known folder icon; in the case of color 
sets, the folder icon is also marked by colors.

You can view the color sets created for a different paper grade by selecting this paper grade in the list 
box at the top right. In the field, a color set is mainly used only with one particular paper grade. For 
that reason, in Image Control the color sets are assigned to the relevant paper grades.

You can set any text filter (1) using the text box to the right of the paper grade. When you press the 
"Filter active" button (2), only those color sets that match the paper grade and filter setting display; 
in other words the text you entered is found in the folder, color set or ink name (3). Press the filter 
button again to disable the filter and view all the data again.

Directory

Color set
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Buttons in Color archive

Copy a color set/color: Use these buttons to copy the selected color set or color. 

• Left button:

A copy of the selected color or color set is created and filed to the clipboard. The current copy 
displays in the preview between both buttons. 

• Right button:

Use the right button to paste the copied color to the color set currently marked or a copied color 
set to a folder. A virtual keyboard displays if a color of this name already exists when you copy 
a color in a target color set and you must change the name of the color you will paste.

As a general rule: You can paste color sets only to folders and colors only to color sets. When 
you paste copies of a color set to different folders, these copies are independent of one another. 
This means that even if the names are the same, changes to one of the copies are not applied 
to the other copies.

You cannot add to the color sets shipped with the system. The button is disabled if such a color 
set is selected in the table. The same is applicable to color sets that are locked.

Using this clipboard, you can copy colors from one color set to another and also create a copy 
of a color with a new name in the same color set.

Create new folder: When you press this button, a virtual keyboard displays that you can use to enter 
the name of the new folder. This requires that the higher-ranking folder in which you will create the 
new folder is selected in the table. The button is not enabled if a color set or a color is selected in the 
table.
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Create new color set: An input window with a virtual keyboard displays where you can enter the 
name for the new color set. The name must be different to any of the color sets currently in the 
selected folder. The new color set (that still has no colors) is created in the selected folder when you 
press the OK button.

This requires that a folder in which you will create the new color set is selected in the table. The but-
ton is not enabled if a color set or a color is selected in the table.

Delete a color set/color/folder: This button lets you delete a selected item after you confirm an alert 
message. You cannot delete the color sets shipped with the system or color sets that are locked. The 
button is disabled if such a color set or color is selected in the table. If you delete a folder, all the 
color sets found in this folder are deleted.

ABC: This button lets you display a virtual keyboard that you can use to change the name of the color 
set, color or folder. You cannot rename the color sets shipped with the system or color sets that are 
locked. The button is disabled if such a color set or color is selected in the table.

Lock (local color archive only): Besides the shipped color sets that cannot be changed, you can also 
lock custom color sets so they are not changed. These color sets then cannot be deleted nor can the 
colors in them be edited. You also cannot delete folders which contain locked color sets.

To protect a color set from changes, select it in the color database and press the Lock button. The 
color set is tagged by a lock icon in the column on the very right and you can no longer edit or delete 
it. This lock is removed only when you select the color set and press the Lock button again, making 
changes possible again.

You can only lock whole color sets and not single colors.
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Select as default

The selected color set is set as the default for new jobs and marked accordingly in the color database. 
If the same color set is generally used for jobs, this option lets you simplify processing of the jobs 
because you then only have to assign a color set if a job has a deviating color set. The button is dis-
abled if a folder or a color is selected in the table. As a prerequisite, the color set must contain pro-
cess colors B, C, M and Y.

There is only one default per paper grade. The color set of the predecessor job is used as the default 
if the paper grade is the same as in the predecessor job. Only when you change the paper grade is 
the default color set of the new paper grade used.

You can disable the default by pressing the selected color set again.

Modify: Opens the "Change color set" window for the color set selected in the list (see sections 
below). You cannot edit shipped color sets. However, you can copy these color sets and edit the cop-
ied versions.

Create a new color set based on an existing color set

You cannot edit or delete color sets that are shipped with the machine. You use them as a template 
to create new color sets. You can create a new color set if you define new reference values and wish 
to use them later for other jobs. 

1. Select the appropriate paper grade by pressing the list box at the top right (Gloss coated, Matt 
coated, Uncoated). 

2. In the table, select a color set as a basis for a new color set, making sure that none of the colors 
in the color set are marked. 

3. Press the "Copy" button.

4. In the table select the target folder to which the new color set will be copied.

5. Press the "Paste" button.
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6. Image Control generates a full copy of the selected color set. This new color set contains copies 
of the reference values for all the colors in it. If the selected folder already has a color set of the 
same name, the virtual keyboard displays automatically when you paste the color set, letting 
you enter a different name for the color set you will paste. In this way, you can also create copies 
of the color set in the same folder.

7. Mark the new color set in the list and press "Modify". The "Change color set" window opens.

8. Define the reference values of the new color set. To do this, you can measure the colors again, 
assign set Lab values and edit density values and density filter (see "Edit a color set", page 179).

Copy a color (add to color set)

You can copy the colors of an editable color set and in this way add to a color set, for example, to 
create a color set for a machine with eight printing units based on a 4-color set.

1. First, proceed as when creating a new color set and in the list of color sets select the color set 
you will add to. 

Note: You can also copy a color in a different color set and then paste it to the color set to 
be enhanced.

2. Highlight the color to be copied.

3. Press the "Copy" button: The copied color now displays in the preview.

4. Select the target color set and press the "Paste" button. If a color of this name already exists in 
the color set, the virtual keyboard displays, letting you enter a name for the new color.

5. Press the OK button in the virtual keyboard.

In many cases, you will now see a message, telling you that the paper white of the color you will paste 
does not match the paper white of the color set.

�
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6. Select whether to use the paper white of the color set also for the new color (the new color is 
then converted to the paper white of the color set) or whether to apply the paper white setting 
of the color you will paste to the whole color set.

7. Press the OK button. The new color now displays in the list.

8. If you wish to use always the same color value as the basis for new colors, you can display the 
virtual keyboard each time by pressing the "Paste" button and then create further copies of the 
color by assigning new names. To use different colors as the copy basis for new colors, you must 
first highlight a color each time and then press the "Copy" button. 

9. If necessary, define the reference values for the new colors. To do this, you can measure the col-
ors again, assign set Lab values and edit density values and density filter (see "Edit a color set", 
page 179).

Note: You may not have to enter a new color name when you copy colors from other color 
sets to a color set. For a better overview you should then edit the name of the pasted color 
by pressing the "ABC" button. 

Edit a color set

You can measure the color values of a good sheet and assign them to an editable color set. The high-
precision single measuring head then moves to each color patch set in the scan of the good sheet and 
measures it. 
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1. Select the appropriate paper grade (Gloss coated, Matt coated, Uncoated). 

2. Highlight an editable color set in the table or create a copy of one of the existing color sets. You 
cannot edit shipped color sets. 

3. Press the "Modify" button. The "Change color set" window opens.  
The colors in the color set you selected in the table display their current values in the section 
below the preview window.

4. Place the good sheet or color fans on the measuring table and press the scan button. A scanned 
image of the recorded good sheet now displays in the preview window above the color set table. 

First of all, you must determine the paper white in the sheet as the reference value for the colors. 
Only after that can the single colors be measured whose values are then in relation to paper white. 

By default "Paper" is enabled when you invoke the "Change color set" window. In other words, you 
can start measuring of the value for paper white right away.

Normally, the paper white of the good sheet is determined only once and after that all the colors are 
measured one after the other. Only in a few special cases, for example when measuring color fans, is 
it advisable to redetermine paper white before each color is measured. You are then asked each time 
whether you wish to keep the paper white of the color set or to use the remeasured paper white val-
ues.

All colors of the color set are converted to the new paper white if the remeasured paper is used for 
this color set. Slightly different Lab values and densities result.

If the old paper white of the color set is kept, colors measured as of that point are converted to the 
old paper white.
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Note: When you measure paper white and colors, we recommend that you scale up the 
overall view of the good sheet section by section to be able to place the selection tool more 
accurately. Use the buttons at the top right to scale up or down the sheet view. You can 
move the scaled-up section directly in the preview.window.

5. Move the selection tool to the area of the good sheet image where you will measure and set 
paper white. 

The preview section on the right displays the Lab values of the currently selected target area and a 
preview of the color.

Note: The values of the preview shown may deviate slightly from the final color data. 

6. Press the "Assign" button when the values for paper white are correct. If not, move the selection 
tool until you see acceptable values.

7. You will see a message, saying that the measured paper white does not match the current paper 
white of the color set. Select whether you will apply the new values measured for paper white 
to the color set or whether you will keep the old values and press the OK button.

Note: You can still edit the value for paper white if you are not satisfied with its value and 
have already pressed the "Assign" button. Simply repeat the measure procedure for "Paper" 
at another position on the good sheet. 

After you press the "Assign" button, the single measuring head moves to the selected position on the 
good sheet and measures the position. The values in "Paper" change accordingly once paper white is 
defined. You can now measure the color data you want. 

8. Highlight one of the colors for which you wish to measure a modified color value from the sheet. 

�
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Note: Use the buttons for scale-up, scale-down and overall view of the scanned image at 
the top right of the "Change color set" window to view the area you want in the scanned 
image. 

9. Place the selection tool over the area where the color currently highlighted in the table will be 
measured. The Lab value for the color displays in the lower preview.

Recommendation: Do not use micro strips as measuring points because scattered light effects or 
faulty measuring can result if the selection tool is not calibrated properly and because of the small 
areas for measurement.

10. Press the "Assign" button. The Lab value for the color is modified in the list. If you are not sat-
isfied with the result, reposition the selection tool and press "Assign" again. 

11. Now highlight the next color in the list to be measured and repeat the procedure.

12. When all the colors are measured, conclude by pressing the "OK" button to apply the changes 
to the color database.

"Paper" and "Color" buttons and displays: You can toggle between measuring paper and colors 
using the "Paper" and "Color" buttons. Only the "Paper" button is active if no paper was measured 
so far. After paper is measured, the "Color" button is active and selected automatically. The selected 
button is white.

The previews for paper and color each display the relevant colors.

The Lab display for paper shows the measured Lab value of the paper.

The Lab display for color shows the Lab value last measured for the color, relating to the paper of the 
color set in the table.

Other functions in the "Change color set" window

Create a new color: When you press this button, the virtual keyboard displays for you to enter a 
name for the new color. A new color item is created when you press the OK button and its Lab values 
are "0" and "B" is set as the density filter.

�
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Note: You can delete and rename colors only in the color database itself. 
The functions described below for manual editing of the color values are disabled while 
"Paper" is selected.

"Lab" button: Changes the color values 
Press this button to display a dialog where you can manually edit the Lab values of the selected color. 
The selected value box has a dark gray background and you enter the values using the on-screen key-
board.

Colors for which you manually edited the Lab values are highlighted by an icon in the color box.

Points to note with Lab input and ISO color set

Each color set has a paper white value with which this color was measured.

Normally, the Lab value of a color is converted with paper white of the sheet (production run paper) 
and paper white of the color set.

The changes in the Lab values that result from this are usually minor because production run paper 
white in most cases does not differ greatly from paper white of the color set.

The Lab values are to be reached precisely for colors with Lab input. There is no conversion to paper 
white of the sheet. In the color database, these colors are highlighted by the Lab icon beside the color 
box.

The Lab values of the colors of the ISO color set included in the shipment are also not converted to 
paper white of the sheet.

�

�

Prinect Image Control  –  User’s Guide 183



Malfunction/Service > "Service" Workspace
"D" button: Changes density 
A density value is calculated from the spectral measurement. Press the "D" button to display a dialog 
where you can edit the density value. Use the plus/minus buttons to edit the density for the selected 
color by 1/100 in each case.

Color control is only by the Lab value of colors with manually entered Lab values. No density is shown 
for them. The "D" density and "(B)" density filter buttons cannot be used and are dimmed.

Density filter button: Changes the density filter between Y, M, C and B 
Image Control automatically uses the filter that gives you the highest density which is the optimal 
density filter in most cases. This button lets you open a dialog where you can go between the density 
filters if you wish to set a different density filter for the highlighted color despite this. 
The button shows the current value for the density filter selected for this color.

Central Color Master Database

If a MDS server is configured (see "MDS configuration", page 206), you can select whether you want 
to work with the local color archive ("Local") or with the central color master database ("Server").
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The MDS variant of the color archive is slightly different to the local variant:

• No color sets display, but folders where the color data are stored.

• In contrast to the color sets, the folders do not contain any paper white because paper white 
data is saved with its related color. This means that the colors within a folder can also have dif-
ferent paper white data.

Transfer local color data to the central color master database

1. Select the "Local" setting.

2. Mark the color set or color that you wish to transfer.

3. Press the "Copy" button: The copied color now displays in the preview.

4. Select the "Server" setting. The central color master database displays.

5. Select the target folder and press the "Paste" button.
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1up archive

Prerequisite: The "Proof Match" license must be installed to be able to use this function.

In the 1up archive, you can save 1up types defined for controlling and load them if needed to jobs of 
the same kind. These can be 1ups defined manually but also 1ups derived from a sample sheet/proof.

For a description on how to archive and reuse 1up types, refer to the following section: 1Up Archive, 
page 155.
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Functions in the 1up archive

Description of buttons from left to right:

• New folder: A new folder is made in the selected folder, and an on-screen keyboard appears 
where you can type a folder name. If a folder with this name is already present in this folder, the 
name turns red in the on-screen menu and the OK button is disabled.

• Delete: If a 1up is selected, it will be removed from the database after you have confirmed a 
security query. If a folder is selected, it will be removed from the database together with all its 
subfolders and the 1ups contained therein after you have confirmed a security query.

You cannot delete locked folders or 1ups.

• Rename: Opens the on-screen keyboard where you can type a different name for the currently 
selected folder or 1up. You cannot rename a folder if this folder has a locked 1up.

• Lock for editing: Press this button to lock the selected 1up (the column to the right will show a 
lock icon). In this case, the functions "Delete" and "Rename" are disabled if such an item is 
selected. Pressing the button again will unlock the item.

• 1up from sample: Opens the window "1up from sample measurement" where you can capture 
1ups from sample sheets (for a description, see 1up from Sample Sheet, page 157). A target folder 
must be selected for this.

Measuring elements 

This database contains all the color control strips, minispots and masks that can be used in the jobs 
and those that are, for example, temporarily not in use. In the "Measuring elements" tab, you can 
select control elements that are then available for selection in job processing in "Measuring ele-
ments".
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For easier identification, a preview of the measuring element currently selected in the list displays on 
the right. You can use the slider below the preview to shift the image if previews do not fit completely, 
which is the case with color control strips containing many color patches, for example.

The following displays below the name of the control element:

• Number of measurement fields

• Number of colors involved (e. g. CMYK=4)

• Size (width and height) in mm

Note: To speed up the search for color control strips, the list should only contain the ele-
ments that you actually use.

The descriptions below show you how to edit the list of color control strips. You can also edit the lists 
of minispots and masks in the same way. To do so, you only have to select the other sub-tab in the 
"Measuring elements" tab. 

1. Press the "Service / Malfunction" button in the header. 

2. Press the "Service" button (wrench icon). 

3. Press the "Measuring device settings" button in the navigation bar and select the "Measuring 
elements" tab. 

Use of control strips

Only the color control strips that are in the "Measuring Elements Used" list are available to you when 
selecting the control strip. You can move color control strips from the "Unused Measuring Elements" 
list to the "Measuring Elements Used" list and then use them. 

This division lets you speed up your search noticeably after a sheet scan and facilitate the selection 
of control strips in the job by presenting or looking for only those control strips that are used in the 
job. 

�
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Exclude color control strips from use

1. In the "Measuring Elements Used" list, select the color control strip that you want to remove 
from this list. 

2. Press the arrow button. The color control strip displays in the "Unused Measuring Elements" list. 

Use color control strips

1. In the "Unused Measuring Elements" list select the color control strip that you wish to move to 
the "Measuring Elements Used" list. 

2. Press the arrow button. The color control strip displays in the "Measuring Elements Used" list. 

Edit other types of control elements

To edit the list of minispots or masks instead of the color control strips, press the appropriate button 
at the bottom left (buttons from left to right: color control strips, minispots, masks). The lists are 
edited in the same way as that for color control strips.

"Mini Spot Plus" option: Import custom measuring elements

If you have a "Mini Spot Plus" license, you can transfer custom measuring elements to Prinect Image 
Control with a USB stick and use them there.

1. Create the following folders on the USB stick:

• "Mask" for masks

• "Minis" for minispots

• "strip" for color control strips

2. Copy the measuring elements to be imported to their folders on the USB stick.

3. Plug the USB stick into the port on Prinect Image Control (see "USB ports (5)", page 27).

4. Select the "Measuring elements" tab in "Service > Measuring device settings".

5. Select the type of measuring element you want to import.

6. Press the "Import" button.
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7. The list on the right shows all the measuring elements that can be imported.

8. Mark the measuring element you want to import and press the left arrow button.

Process standards archive 

You wil find a list of all available process standards in the "Process standards archive" tab. You can 
select one of these process standards during job preparation in the "Reference values" step (see "Ref-
erence values", page 74). 

Note: If a MDS server is configured and you are working with the centrally managed process 
standards on a server, you can only edit the default for the three printing materials in the 
"Process standards archive". No changes to the central process standards can be made in 
this tab.

1. Press the "Service / Malfunction" button in the header. 

2. Press the "Service" button (wrench icon). 

3. Press the "Measuring device settings" button in the navigation bar and select the "Process stan-
dards archive" tab.

This is where you can specify which process standard will be set by default for the three printing 
materials (= green dot) to save you having to select this during job preparation. Irrespective of the 
default, you can set any other available process standard for a specific job in job preparation.

4. To select a different process standard as the default one, mark the row you want and press 
"Default".

�
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Other functions in "Process standards archive"

Export PSO: This function lets you copy custom process standards to a local directory, creating a 
backup in doing so.

Caution: In an Image Control update from version 11 to version 13 or higher, you must cre-
ate this backup for all process standards that you wish to continue using after the update 
because process standards are lost during an update.

Import PSO: Press this button to open the "PSO Export" directory in a browser window where you 
will find all the process standards that were exported. 

Highlight the ini file you wish to import and press the OK button. If there is already a process standard 
of the same name, a query will be issued, asking you whether you wish to update the existing process 
standard, in other words overwrite it with the imported process standard.

Delete: You can remove custom process standards with this button. No alert message is issued. You 
cannot delete process standards included in the shipment; the Delete button is dimmed if such pro-
cess standards are highlighted in the list.

Load IC1 process standards: Use this button to open a browser window that lets you import stored 
process standards from Image Control 1.
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Edit a process standard: Press the "Modify" button to open the "process standard overview" for the 
currently highlighted process standard. This is where you can customize the parameters of the pro-
cess standard.

When you go to edit one of the shipped process standards, a copy of it is generated automatically 
because you may not modify process standards included in the shipment. You can save modified pro-
cess standards under a new name.

You can edit the values by selecting the color in the overview, pressing one of the input boxes and 
entering the values you want using the on-screen keyboard. You delete all the values for the selected 
color including the color name by pressing the Delete button.

You can also define values for density and density tolerance in the process standard. Press the button 
with the lock icon to unlock the input boxes for density. After that, you can press the "D" and "Tol. D" 
input boxes to enter the values you want using the on-screen keyboard. 
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Measuring conditions 

The basic conditions for measuring colors display on the top left. You cannot edit some of these set-
tings, they are for your information only.

Selection of the measuring condition:

• M1

D50 - daylight illumination; optimal measurement condition for the ISO-12647-2:2013 process 
standard. The UV optical brighteners used in modern papers, however, greatly affect measure-
ments using this measurement condition.

Note: Color control is only possible via the color strip when you select M1 as measurement 
condition. All image control functions are hidden.

• M2

UV cut filter; when this measurement condition is used, the UV optical brighteners used in mod-
ern papers are fully suppressed and do not affect the measured data.

Note: Changing the measurement condition only affects new jobs; open jobs will not be 
affected.

In the process standards, it is always assumed that  illuminant D50 and observer angle 2 are used. 

• D50: Daylight, slightly reddish 

"D" stands for the standard illuminant and is equivalent to measuring outdoors. Standardization 
includes the invisible UV range between 300 and 380 nm. "50" stands for a color temperature 
of 5000 Kelvin. The radiation distribution in the light source is specified in this standard illumi-
nant. This value is often used in the graphic arts industry as the illuminant for the assessment 
of originals, proofs and prints.

D50 is the standard measuring condition for print approval in Europe. 

• Observer angle 2°: Observer angle 2° simulates the typical situation for reading books and mag-
azines.

Below that you can set the basic values for calculation of density.

• Density measurement: Filter type setting "M1" (= M2 with UV excitation), "M2" (non-polarized) 
or "M3" (polarized) 
The type of filter also displays for density in "Measure/Controls > Overview > Measuring values": 
"D(M3)" for polarized, "D(M2)" for non-polarized.

• Density filter standard: Selection of the standard that defines the color density filter 
To be able to compare the density values with those of other measuring devices, for example a 
hand-held densitometer, you must use the same settings for density and filter. It is also recom-
mended that you calibrate the other measuring device to the Image Control calibration chart.

�
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• Reference white for density measurement: "Paper white" means that density is measured in rela-
tion to the brightness of the printing material. "Absolute white" means that the brightness of the 
printing material is disregarded in density measurement. 

On the right, defaults can be set for the calibration space used and the color difference formula that 
will be used for calculation of the ΔE value (by the service technician). The way how the color differ-
ence is to be specified can also be set.

• Calibration space: Selection between X-Rite Graphic Arts Standard ("XRGA") and "GMB"; the 
default is "XRGA", the current calibration space that supports the use of X-Rite and Gretag mea-
suring devices. Switching to "GMB" only makes sense if you already worked with a predecessor 
version of Prinect Image Control and Gretag measuring devices and if you have numerous repeat 
jobs that are to be comparable to the new values.

• Color difference formula: Selection between "CIELAB" and "CIEDE2000" (ΔE 2000); the color 
difference formula is used to calculate the ΔE value that denotes the difference between two col-
ors in the color space. Under favorable viewing conditions, a ΔE value of "1" to "2" is barely per-
ceptible to the human eye. ΔE "CIELAB" is the definition for calculation of color difference based 
on the ISO standard of 1976. The more recent formula, ΔE 2000, is significantly more complex 
and produces more accurate values. ΔE 2000 is more suited than ΔE CIELAB especially when 
replacing spot colors.

• Color difference: Defines how the color difference is displayed. "Absolute" indicates the theoret-
ical value, regardless of whether this value can be reached at the press. "Correctable" means 
that only the value that can be achieved at all by controlling the press is used in the calculation 
of the ΔE.

Job list 

In "Job list", you can view a list of all the jobs saved in this Image Control system. You can view either 
a complete list of jobs or the jobs per machine. If you wish, you can sort the jobs by a certain crite-
rion, e.g. by the job date. You can also copy jobs or delete them irrevocably from the list.

The content of the list is equivalent to the jobs that you see loaded from the "internal database" in 
job preparation with "Load job", only that in this case you have a press-independent overview of the 
jobs.

You can view details about the currently selected job when you press the Info button.

Start-up/Press information

In addition to details about the software and hardware version of your Image Control system, this is 
where you will find license administration and selection of the press with which you will edit and 
assign the data of the connected presses.
Prinect Image Control  –  User’s Guide 195



Malfunction/Service > "Service" Workspace
Note: The "Hardware information", "Software information" and "Variant code" tabs are for 
information only.

Hardware information 

This displays the 12 measuring modules with their ID and serial number as well as the serial numbers 
and geometry data of different hardware components.

Software information 

In this tab, you will find the version number and the date of your Image Control version as well as the 
serial numbers of various firmware versions. Use the "Patents, rights" button to view legal notices 
about the third-party and freeware products used in this software.

The current state of the MDS server displays in the "MDS" box if you are working with the MDS server 
(see "MDS configuration", page 206). The local version may not be more recent than the server ver-
sion.

You can view all the installed software modules and their status in the "Licenses" tab (see "Licenses", 
page 197).

The operating manual displays in a separate window when you press the "Operating manual" button. 
On the left you can see the Table of Contents that you can use to go directly to a certain topic, the 
content of the Help page displays on the right. You can scroll forwards and backwards or go to the 
start page by pressing the arrow buttons on the right part.

If you displayed various pages one after the other using the Table of Contents, you can toggle 
between them (irrespective of the order they are in the manual) using the buttons at the bottom left.

Press the button at the bottom right to close the operating manual.

�
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Licenses 

Various plug-ins that extend the range of functions or enable peripherals to be connected are avail-
able for the measuring devices. You can view all the installed software modules and their status by 
clicking the "Licenses" button.

1. Press the "Malfunction/Service" button in the header.

2. Press the button with the wrench icon.

3. Press "Start-up / Press information" in the navigation bar and then the "Licenses" button.

All the installed software modules are listed in the left list. Their status is indicated by a symbol at the 
beginning of the row.

• green dot: software module is enabled for an unlimited period

• green time icon: software module is enabled for a limited period

• yellow dot: license requested 

• red dot: software module is not enabled

Note: "MasterLevel" is the basic license. You can enable the remaining options only if "Mas-
terLevel" is already enabled (= green). 
Netprofiler: Enables the Netprofiler for calibration (otherwise only verification) 
Proof Match: The basic functions of 1up image control is supplemented by the 1up archive 
(saving and loading of 1ups), capturing of 1ups from the sample sheet and the "1up informa-
tion" function (see section "Define Image Areas > 1Ups", page 149). 
Offline Inspection: Exports the latest sheet scan data of the BME to a hotfolder for evalua-
tion via the PDF inspection system (see section "Overview > Export Image Inspection Data", 
page 116) 
Mini Spot Plus: This license lets you import custom measuring elements from a USB stick 
and use them with Prinect Image Control (see ""Mini Spot Plus" option: Import custom mea-
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suring elements", page 189). You can also refer to "Color analysis" where you can compare 
any homogeneous color patches with the reference values (see "Measuring range > Color 
analysis", page 159).

Activate License

1. Select the software module you want in the list.

2. Press the "Use software module" arrow button.

The selected software module now displays in the list on the right, and the "Demo key" and "Options 
key" buttons are enabled.

Note: You cannot enable the "MasterLevel" basic license as a time-limited demo version 
("Demo key" button is dimmed).

3. Press the "Demo key" button (button with a calendar icon) for a temporary license or the 
"Options key" button for a license with an unlimited period.

A key code is issued in the display. The yellow dot at the beginning of the row indicates the "License 
requested" status. A time icon also displays for a license limited in time.

The software module is removed again from the right list and the status display in the left list changes 
accordingly.

4. Communicate the key code to your Heidelberg agency.

�
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5. After you received the license key from your Heidelberg agency, display the "Licenses" window 
again.

6. Mark the software module whose license key you have received.

7. Press the "Enter license" button.

8. Enter the license key you received using the screen keyboard.

9. To conclude, press the "OK" button.

The status of the software module now changes from yellow to green, indicating that the module is 
now enabled.

Notes:

• Some software modules display as enabled only after a restart.

• When a license that is limited in time expires, a message in the "Malfunction" tab indicates this 
to you. You can access your demo license only for another 10 days when you see the "License 
will expire shortly" message.

• You can turn your demo license into a license with an unlimited period by selecting the demo 
license, generating a key code again with the "Options key" button and requesting an unlimited 
license from your Heidelberg agency with the new key code.

Other functions in the "Licenses" tab

Note: These functions may only be performed by service technicians. 

Reset licensing: Inconsistent licensing data may occur as a result of hardware malfunctions or the 
replacement of hardware components. In this case, the box with the available licenses remains 
empty.
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You can trigger a full deletion of the licensing data with the "License reset" button. A successful reset 
of the licensing data is indicated by a dimmed "License reset" button and by an unlicensed "Master-
Level" in the box with the available licenses. After that, you can license the software modules once 
again.

Delete license: The selected license is deleted after you confirm an alert message. In other words, 
the software module is disabled. Demo licenses are deleted immediately. Regular licenses are deleted 
only after a follow-up period.

Press Configuration 

1. In the "Service" window press "Start-up / Press information" in the navigation bar and select the 
"Press Configuration" tab. 

The press database contains the main machine data of the connected presses. This database needs 
to be accessed only if the machinery is changed or added to. You can configure as many as eight 
presses but only a maximum of four can be assigned. 

In this process, a difference is always made between "Network" machines (= machines that really 
exist) and "Autonomous" machines (= virtual machines).
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Note: If you change the assignment of a machine or edit its configuration, the current job 
of this machine is lost. Save any current jobs before you make changes to the press config-
uration.

Use the buttons in the lower part of the window to assign the machines available in the list to the four 
machines used in Image Control.

1. To do this, mark the press in the "Available machines" list. 

2. Press one of the buttons below "Assigned Machines". The item is assigned to this "machine" at 
Image Control after you confirm a query. If another item from the "Available machines" list was 
already assigned, this assignment is removed automatically and "No" displays in the table in the 
"Assigned" column. 

• You cannot reassign machines that are already assigned. 

• You cannot change the assignment of a machine that is currently active. 

Defining a new press configuration 

1. Press the "New Press" button in the "Press Configuration" tab.

�
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2. The "Create New Press Configuration" window opens where you can enter your settings for the 
new configuration: 

• Type: "Network" refers to real presses that can be addressed in the network. "Autonomous" 
refers to virtual machines that are required, for example, for sample measurements or for test 
purposes. 

• Name or IP: Network name of the press or IP address of the press in the network. You can enter 
either the network name or the IP address. Then press the "Check Network Accessibility" button. 
Image Control now looks for the connection in the network and, when connected successfully, 
automatically fills out all the other boxes with data of the press.

For autonomous (virtual) machines, you still have to define the settings described in the next section 
for configuration of the machine. For network machines, these details are supplied by the machine 
and cannot be changed. You only have to select the monitor display and, if necessary, set a variant 
for these machines.

3. Press the button beside "Monitor Display". The "Select Color" window displays where all avail-
able color tags are listed. 

The select button of color tags that are already used is dimmed. 

4. Mark the color you want and press the OK button. The button beside "Monitor Display" now dis-
plays in the color you assigned it. 

5. Press the "Designation" box and type in a short name (e.g. relating to the setup or site) for the 
machine on the virtual keyboard. This name displays together with the "Monitor Display" at the 
bottom right in the footer of Image Control.

6. To conclude, press the OK button in the "Create New Press Configuration" window as well. The 
new configuration nows displays as inactive and not assigned in the "Available machines" table. 
You can now assign the new press configuration to one of the "machines" on Image Control 
(except for the currently active machine) to work with the new configuration.

Note: The OK button is enabled only after all necessary data were input in the "Create New 
Press Configuration" window.

Additional details for "Autonomous" machine types

Because no details are sent by a machine in the case of autonomous machines, you must enter the 
following configuration data yourself (described from left to right and top to bottom).

• Selection of the press type 
The press type also determines the plate size and the variants available for selection

• Selection of the variant, if any
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• Number of zones 

• Zone width in mm 

• Number of printing units 

• Position of the first and any second perfecting 

• If a perfector is set (= printing unit after the perfector) you can enable front and back printing 
with the button below "Designation". If two perfecting operations are set, you can use the two 
buttons to select which perfecting is for printing the back.

• You can edit the colors assigned to the printing units by pressing the "Color allocation" button 
for "simulation". 

1. Press a color button in the "Color allocation" window. 

2. Press the printing unit to which you wish to assign the selected color. The printing unit displays 
with the relevant color tag, and the color is check-marked as "assigned". 

3. After all the colors you want are assigned to all the printing units, close the dialog by pressing 
the OK button. 
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Caution: You must reassign the colors if you make changes in the "Create New Press Con-
figuration" window after colors are assigned. For that reason, assignment of colors should 
be your last step.

Delete press configuration 

1. Highlight the press configuration to be deleted in the list. You cannot delete the currently active 
configuration.

2. Press the "Delete" button. The selected configuration is deleted after you confirm an alert mes-
sage.

Caution: Jobs in this press configuration that are not saved are lost in this process. You can 
load and use saved jobs in this press configuration on other machines of the same kind 
(same number of printing units, sheet size, etc.).

Edit press configuration 

1. Highlight the press configuration you wish to edit in the list. You cannot edit the configuration of 
the active machine. When you edit inactive, but assigned press configurations, assignment is 
revoked and you must reassign it, if necessary, after editing.

2. Press the "Edit Press Configuration" button. The same window as for creating a new press con-
figuration displays and you can edit the configuration values there.

Note: If you edit an inactive but assigned press, you may see a warning after you press "Edit 
Press Configuration" informing you that the current job will be lost on this press. You can 
then still cancel editing of the press configuration and save the job data.

Variant code 

This displays the serial number of the device ("CP300xxx*") that is entered during initial start-up and 
the number of ink zones and type.
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Integration/System

This is where you can connect Prinect Image Control to Integration Manager or Pressroom Manager 
and set up a network folder for saving PDF print files. You can also make network and regional set-
tings such as setting the UI language.

Prinect Configuration 

The network directories for the export of Quality Monitor data, loading of PPF data and output of PDF 
data are set in this tab.

Color data export

Analyze Point (Configuration of color data export)

When this shared network folder is set up, the measured data of all the measuring elements are 
always exported to it whenever data are released to the press. You can then evaluate this data with 
Prinect Analyze Point or Prinect Color Toolbox.

Share folders

This requires that a directory with enabled read and write permissions is on the computer concerned.

1. Press "Configuration of color data export".

2. Press the "Base folder" box in the "Color measurement directory" dialog and type in the network 
path to the shared directory using the screen keyboard using the following syntax: \\comput-
er_name\shared_folder, e.g. "\\PC001\AP-Output".

Note: You can only specify the shared folder itself, not the the subfolders it contains. In the 
latter case, the font in the dialog turns red to indicate an invalid entry.
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3. Enter your user name valid for the target computer including domain (!) and your password (the 
password is encoded and displays as asterisks when you enter it).

4. The button next to the "Hotfolder" box is enabled if all entries are correct: Press this button and 
choose the hotfolder to which you want to have the data exported in the dialog that follows.

5. Confirm both dialogs by pressing the OK button to to accept the folder.

Use the Delete button to clear all input boxes in the "Color measurement directory" dialog. When you 
close the dialog with OK, the set directory is removed from the configuration and color data are no 
longer exported.

Note: The color data are exported automatically to Analyze Point whenever the press sheet 
is released for the press.

Inspection Output Folder

Prerequisite: The "Offline Inspection" license must be installed to be able to use this func-
tion.

In the "Overview" section of the "Measure/Controls" workspace you can export the image data of the 
latest sheet scan into a hotfolder that is connected to the PDF Inspection System (see "Overview > 
Export Image Inspection Data", page 116). For this purpose, this hotfolder must be specified as target 
folder in the "Prinect Configuration". Do this in the same way as you would specify the folder for the 
color measurement data.

MDS configuration

This is where you can set the central server for the Prinect Master Data Service. After the server is 
selected, the process standards there are accessed. At all points where color data is accessed, for 
example, in the color archive or with the reference values, you can select whether you wish to use 
the central color master database on the server or the locally stored data.

If you use the process standards from the server, you can open these process standards as read-only. 
It is not possible to edit them on the local computer. You can only select which process standards are 
set by default.

The MDS variant of the color archive is slightly different to the local variant:

• No color sets display, but folders where the color data are stored.

• In contrast to the color sets, the folders do not contain any paper white because paper white 
data is saved with its related color. This means that the colors within a folder can also have dif-
ferent paper white data.

Using the Copy function of the color archive, you can transfer single colors to the central color master 
database as well, making them available for all users.

1. Press the "MDS configuration" button.
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2. In the "Prinect Master Data Service" dialog, enter the name or IP address of the server in "Name 
or IP" and, if necessary, the port in "Port". You must enter just the server name without the 
domain or "\\".

3. Press the "Check Connection" button.

4. If the connection test is successful, press the OK button.

(5). After that, you can, for example, select between a "Local" or "Server" setting in the "Color 
archive".

The current state of the MDS server displays in "Start-up / Press information > Software information".

PPF input directory

To be able to import PPF data to a job, you must have entered all the network directories that will be 
available for this as input directories in Prinect Image Control. The PPF data of these directories then 
display in "Job data" when you press "PPF import".

Note: Only the data located directly in the shared directory display, files stored in subfolders 
do not display.

Prerequisite: A directory with enabled read and write permissions is on the computer con-
cerned.

Specify the PPF input folder in the same way as you would specify the folder for the color measure-
ment data. You can enable the following options for the PPF input folder:

• "High-quality PPF image data" 
Image data with less than 50 dpi will not be written to the folder.

�
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Note: You recommend that you use only high quality PPF image files (min. 50 dpi) because 
homogeneous colors cannot be controlled if this is not the case.

• "Prinect Prepress" 
Only PPF data from the Prinect Prepress workflow will be written to the folder. This makes it eas-
ier to correctly evaluate the data. We recommend that you set up separate PPF input folders for 
each of the workflows if you use Prinect Prepress data and also PPF data of other workflows. 
The "Prinect Prepress" option must not be enabled for the OEM workflows.

You can mark a path in the list in the "PPF input directory" dialog and either modify it with "Edit" or 
remove it from the list with "Delete" (only the list item is removed, the directory on the external com-
puter is not deleted).

These changes affect new jobs only: In the case of stored jobs, the PPF is also saved along with them. 
In the case of current jobs, the PPF is loaded locally temporarily so that the PPF data are still avail-
able if the directory from which this PPF originates is no longer accessed.

Printer Setup

Print data are saved as a PDF file in a network folder at all points in Image Control that have a "print" 
function (e.g. "Printscreen" button or log data). You can then send these PDF data to a printer when 
required.

1. Press the "Printer Setup" button. 

A table, in some cases with preconfigured print directories, appears.

• This is where you can create new print directories

• and edit, delete or disable existing print directories.

2. Press the "Create" button to set up a new print directory.

3. Select the "Root directory" box and type in the network path to a valid, shared directory with 
enabled read and write permissions using the on-screen keyboard.

4. Enter your user name valid for the target computer including domain (!) and your password (the 
password is encoded and displays as asterisks when you enter it).

5. Now select the hotfolder in the network folder you specified.

6. Press "Connection test". If all inputs are correct, "Connected" displays in green and the OK but-
ton is enabled.

7. Press the OK button to apply the print directory.

If several directories are created:

• The currently used directory has a green checkmark in the "active" column.

• If you wish to use a different directory, mark the item in the table and press the "Activate" but-
ton.

Use the "Print Test Page" button to create a standard test page like on a printer and save it as a PDF 
file in the selected directory.

�
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Network settings 

Overview of all network-relevant data for the Image Control system like network addresses or subnet 
masks. These data are set by the service technicians when the system is set up and display in this 
window for your information only.

Regional 

This tab shows you the basic settings for the date and temperature formats used in your region as 
well as the date and time setting for your system. Normally, these settings are made by the service 
technicians when your system is set up and do not have to be edited.

Please remember: You may have to restart your system after you make changes in the "Regional" tab. 
Save the data of current jobs if you have not done so already.

Press the "Regional" button to open the "Basic settings" dialog:

In "Operation, you can select the language in which the user interface of Prinect Image Control will 
display. The user interface switches over immediately to the language that you selected in the list. A 
system restart is not necessary (exception: Thai).

Press the button next to "Language selection" to open a dialog where you set the UI language, the 
language of the present instructions, and the search language.

Press "Time zone": This opens the dialog for selecting the time zone in which the device is found. 
Depending on the time zone, you can also set daylight saving time/standard time and/or northern or 
southern hemisphere.

Press "Regional" to open the dialog where you can set the following parameters:
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• Date format: This is where you select how the date will be displayed.

• Keyboard layout: Selects the country-specific layout of the on-screen keyboard.

• Unit of temperature: This is where you select whether the temperature will display in Celsius or 
Fahrenheit.

• On the left, you can manually set the current time and the current data with the "jog dials".
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Remote Service 
The Remote Service offers you fast assistance in queries you may have on operation. Remote access 
to the Image Control system, that you must give your approval to, allows Heidelberg service techni-
cians to analyze and eliminate possible faults on your system efficiently. To be able to use the Remote 
Service, the machine is connected to your local computer network during installation by Heidelberg 
service technicians. This network requires access to the Internet that is used for the Remote Service.

This Remote Service lets you and the Heidelberg service technician access your Image Control system 
at the same time so that you can work jointly on the solution of possible issues.
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Remote Service > Activation 

Warning: Risk of injury from remote access! 
Please ascertain the following items before you allow remote access to the machine by the 
Heidelberg service technician:

• All safety functions and safety mechanisms are present and in working order.

• All persons at the machine have received appropriate instructions during the entire duration of 
remote access.

• The safety notes in the operating manual are observed.

Prerequisite: Your system must be set up for access in addition to an existing connection. 
Your customer data and the type of connecting line must be set in "Settings" and permis-
sions for remote service in "Access permission". Normally, these settings are set by the ser-
vice technician during the first start-up.

First, communicate with your service contact by phone and then press the "Connect" button in the 
"Activation" tab. Then coordinate all other steps with your service contact.

When there is a connection, the name of your contact displays in the "Your service partner" row and 
a telephone receiver icon in the footer. The serial number of your machine displays in the "Machine" 
box.

In the activity pane, all activities run by the remote access since the machine was switched on are 
listed in chronological order and without a gap.

To end the Remote Service session, either you or your service contact press the "Disconnect" button.

Notes on connection

• The connection is automatically cut if the service technician does not access your machine 
within 15 minutes after pressing the "Connect" button. The telephone receiver disappears from 
the footer.

• A window displays if Remote Service is still not concluded after 30 minutes. It informs you that 
Remote Service is still active. Press the "Back" button to be able to continue working. The timing 
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of 30 minutes is indicated by a color bar within the telephone receiver icon in the footer. Before 
30 minutes expires, you can restart the time for Remote Service by pressing this button.

Remote Service > History 

The "History" tab lists all the activities that were ever run during Remote Service (even before the last 
shutdown).

The following messages/activities can display in the list window:

Remote Service > Access Permission 

This is where you find the permissions that are possible for Remote Service by Heidelberg service 
technicians. These permissions are normally set during installation and can be changed only with 
Administrator permissions.

• Data transmission

Message/Activity Brief Description

Access by the user Access for Remote Service call was granted.

Connecting Creating a connection to the service portal.

Connected Connection created to the service portal.

Connection not possible A connection to the service portal cannot be created.

Disconnecting Connection to the service portal was cut off.

Disconnecting because no activity Connection is cut off because there is no activity.

Connection terminated by operator Connection to the service portal was cut off by the user.

Connection finished End of connection to the service portal.

Connecting: Data service Connection created for the data service.

Connecting: Application service Connection created for the application service.

Application started: Remote Desktop Displays the application (e.g. Remote Desktop) that was 
started

Application completed: Remote Desktop Displays the application (e.g. Remote Desktop) that was 
exited

File transfer File transfer of the Remote Service tool for file transmis-
sion between the RIP and the service portal.

Service technician Name of the technician presently connected with the 
Remote Service.
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Permits files to be sent on request by a service technician or automatically. A yellow telephone 
receiver displays in the footer when data are being transmitted.

• Remote Access

By agreeing to it, you permit Heidelberg Service interactive access to your machine.

Note: After changing these settings, you must restart Image Control to apply your changes.

Remote Service > Configuration 

This is where you can modify your address details, if necessary, and select a different type of line.

�

�
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Diagnosis 
This is where you can reinitialize your hardware if Prinect Image Control should no longer be opera-
tional. There are additional service functions such as exporting the error messages, and you can 
make settings regarding the colorimetric check, profiling and certification of the colorimeter with the 
"Netprofiler".

Direct operator control 

1. Press the "Service / Malfunction" button in the header. 

2. Press the "Service" button (wrench icon). 

3. Press the "Diagnosis" button in the navigation bar and select the "Direct operator control" tab.

• Reinitialize measuring device

Press the "Initialize" button. Reinitialization of the device hardware starts. This is necessary, for 
example, after system errors like measurements running although the system was not yet ready 
for operation.
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• Park position

You can move the measuring bar to a park position on the very right of the measuring table with 
the right arrow button to clean the measuring table, white pill and reference strip. After cleaning, 
you move the measuring bar back to its starting position with the left arrow button.

• "System log data > Export": All log files relevant for error analysis are exported to the log direc-
tory and can be copied and analyzed by Heidelberg service technicians by means of remote 
access.

• "Job > Export: The data of the current job on the presently active machine are exported to the 
log directory and can be copied by Heidelberg service technicians by means of remote access to 
examine possible issues or bugs in this job.

• "1up/Color archive/Process standards archive > Export": This lets you save the current state of 
the 1up archive, the local color archive or the local process standards archive (e.g. before a soft-
ware update). Your print shop administrator or service technician can import these archives 
again if required. If you are working with the MDS, the process standards archive is managed on 
the server and the export function for the process standards archive is disabled.
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Service 

In "Low-level System Settings", a number of service panels display various tests of single components 
and the overall system as well as calibrations. Prinect Image Control switches to a special mode to 
use the service functions.

Press the "Low-level System Settings" button in the "Service" tab in "Diagnosis" to display a window, 
showing various test functions that are available for the system.

Communication

This test checks whether communication between the system computer and the test hardware 
works and it runs automatically when Low-level System Settings is invoked. In this test, the driv-
ers of the system computer are initialized for communication.

You can repeat the test by pressing the "Communication" button. If there is no connection 
between the system computer and test hardware (for example, because of loose cable links), the 
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dot in the button turns red and no low-level tests can run. Please notify your Heidelberg service 
technician in this case.

Log

This lets you view the results of all low-level settings or tests and create a log in HTML format. 
The current date is used for the file name of the log. You can open the log directly from the mes-
sage window after it is created.

Note: If you create a log again on the same day, the previous log is overwritten without any 
query!

Use the "Delete" button to remove all current items from the log file.

Use the plus/minus buttons to change the font size in the log display.

Suction

• Task

This test checks the suction power of the "Suction" fans that suck the sheet to be measured onto 
the measuring table.

• Test procedure

Caution: Risk of "Suction" fan overheating 
Do not run this rest for too long a period. If run at a high suction power, there is a risk of 
the fans overheating and becoming damaged as a result.

�
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1. Move the slider to the suction intensity you want and press the "Suction" button.

2. Test various suction intensities and listen whether the suction noise changes according to the 
intensity you selected.

3. Disable suction at the end of your test by setting suction intensity to "0".

System information

This lists details about the hardware and software of the measuring bar components and about 
the geometry of the measuring table.

Check white reference element

• Task

Check the white reference of the pill and the reference strip for dirt and replacement of the parts

The reference values of the white pill and white strip are determined during the first start-up. 
Both parts should be checked at regular intervals for dirt (e.g. caused by dry overspray) to pre-
vent falsification of the measured data.

• Procedure

1. Select "Check White Strip Reference" or "Check White Pill Reference" from the list.

2. Press the "Start" button. 

The single measuring head now measures the white pill or the reference strip and the system 
compares the results with the data of the first start-up.
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If the values are in order, you will see the following message: "Deviations are within tolerance" 
or "White pill OK!".

If the values are not alright, first clean the white pill and reference strip and then run the tests 
again.

You must replace the white pill or reference strip if the values are still not alright after cleaning.

White pill: The white pill must be replaced by a Heidelberg service technician.

White strip: A spare white strip is included in the shipment. Note that only the upper white strip 
is removed and replaced by a new one!

1. Go to the "Change White Strip" dialog. The measuring bar moves to the right to make the white 
strip accessible.

2. Remove the upper white strip and stick the spare white strip as accurately as possible onto the 
same position.

3. End replacement of the white strip in the control software.

4. Select the "Generate White Strip Reference" function to measure the values of the new white 
strip and apply them.

Caution: Do not use "Generate White Strip Reference" on a dirty white strip, for example, 
if the test showed that the values were out of range. In this case, these bad values would 
be imported to the system as reference values and all subsequent test results could be 
unusable.

White Reference Position Check

These functions let you check whether the white pill and reference strip are still positioned correctly 
in relation to the mechanical zero point. The position of the white pill is determined by a measure-
ment each in X and Y direction, and that of the reference strip by measuring along both edges of the 
strip.

Please notify Heidelberg service technicians if the results are not in order, in other words, the position 
has moved.

Check BME

With this function, you can compare the BME with the single measuring head.

To do so, you need a special test chart. 

The process will take about 15 minutes.

The deviations between BME and single measuring head are indicated graphically. A red error mes-
sage appears if too great deviations are found. Please contact the Heidelberg service if this is the 
case.

Switch off

• Task
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This test shuts down and restarts the system computer or operation of Prinect Image Control.

· Shut Down System Computer: The application is terminated, the system computer shuts 
down (equivalent to "Shut Down System Computer" in "Measuring device settings > 
Basic settings").

· Shut Down System Computer and "Restart" button enabled: The system shuts down as 
described in the previous section and then restarts automatically.

· Restart application: The Image Control software is exited and restarts again, the system 
computer does not shut down during this, the device remains switched on.

• Test procedure

1. In the test window, press the relevant button(s) depending on the action you want.

2. Press the "Start" button.

The device runs the desired action.
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Netprofiler

Function

Netprofiler makes it possible to "certify" your color measurement system through a data connection 
to a Heidelberg certification server. When you calibrate your color measurement system, you can 
send the data by means of a web-based remote service to Heidelberg. The Heidelberg certification 
server analyzes the color data and creates a measurement report. If the color data are within a set 
tolerance range, a certificate is also created, confirming that the measuring devices works perfectly. 
The certification server sends the measurement report and the certificate by e-mail to an e-mail 
address that can be set.

Prerequisite: The Netprofiler function is included in the software of the measuring device 
and must be enabled by a license (see "Licenses", page 197). The measuring device needs 
a web-based remote service connection for transfer of the data. 
Calibration will take approx. 15 minutes.

Calibration set

Shipment comprises a calibration chart and a USB stick that contains the reference data of the cali-
bration chart. To ensure that calibration is correct, use of the calibration chart is limited to one year. 
You need a new calibration set after this period expires.

Note: Dispose of out-of-date calibration sets. Do this to avoid a mix-up with the new com-
ponents.

Working with Netprofiler

Status

When you press the "Generate profile" button, the "Create profile" window opens at the "Status" step.

1. In the "Status" step, you check whether the Netprofiler license is enabled. If this is not the case, 
go to "Start up/Press information" and there to the "Licenses" tab and enable the Netprofiler 
license (see "Licenses", page 197).

�
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You will find information about the calibration status of your measuring device on the left below "Sta-
tus". The bars in the box above the license details indicate the status:

• Green: Calibration is possible.

• Red: Calibration is not possible because the runtime of the calibration chart has expired or the 
license was not enabled.

• Yellow (after calibration): Calibration was possible. However, the measured data were out of the 
tolerance range.

2. Press the "Next" button.
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Reference data

The reference data are loaded from the USB stick in the "Reference data" step. This requires that the 
USB stick included in the shipment is connected to the device and that the device detected it. Make 
sure that you use the USB stick that is part of the calibration chart.

The reference data must be loaded when Netprofiler is set up for the first time or if the runtime of the 
calibration chart has expired and a new calibration set must be imported. Reference data only have 
to be fed in once for a calibration chart. The reference data are still in the memory for other calibra-
tions run with this calibration chart and you can skip this step with the "Next" button.

3. Fit the USB stick onto a free USB port on the monitor.

The USB ports are on the rear of the monitor. After the USB stick is detected, the display "USB mass 
storage device detected" changes to green. Press the "Refresh" button if the USB stick was not 
detected or if you wish to change the USB stick.
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4. Press the "Load reference data" button. The reference data are now imported from the USB stick 
to the measuring device. A message is issued after the reference data are imported. The new cal-
ibration chart is now ready for use.

Note: Keep the new calibration chart and the USB stick in a dry and dark place.

5. Press "Next".

Check-up

"Check-up" displays in the Assistant. The measuring device now needs the position of the calibration 
chart. The calibration chart has two reference marks A and B.

6. Place the calibration chart on the measuring table.

7. Press the "Next" button to go to the positions.

Now proceed following the instructions in the display pane on the left:

�
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8. Place the light pointer on reference mark A using the arrow buttons of the control panel on the 
measuring bar. 

Note: Move up to the reference marks as accurately as possible using the measuring bar. 
Measurements can be inaccurate if you have deviations greater than 0.5 mm.

9. Then press the confirm button on the control panel.

10. Repeat the procedure for reference mark B.

After you confirm position B, a single patch is measured to check positioning of the chart.

11. Click "Next" if the colorimetric check was successful and the deviation is within the expected 
tolerance range. If measurement failed, repeat measuring of both reference marks by returning 
to the start of the check-up with the "Previous" button".

Create profile

"Create profile" displays in the Assistant. The measuring device now measures the entire calibration 
chart. This process takes approximately 10 minutes.

Wait until the measuring device has finished measuring the calibration chart. The measuring device 
shows the progress of measuring. You can cancel measuring with the "Cancel" button. Other inputs 
are not possible during measuring.

After measuring is finished, the measuring device issues a query: "Do you wish to conclude measur-
ing and use the profile?" Confirm the query with "OK". The profile is calculated.

The following message displays if everything was correct: "Creating of profile completed success-
fully."

12. Press "Next".

Note: You must start with setup measurement of the reference marks again if you canceled 
measuring of the calibration chart or profile calculation.

Create certificate

"Create certificate" displays in the Assistant.

13. Read the messages. They inform you about whether everything worked correctly or whether 
errors occurred.

14. In the upper box, enter the e-mail address for the measurement report and in the lower box the 
e-mail address for the certificate.

15. Press the "Send data" button. The report and/or certificate are now sent. The button is disabled 
after the process is finished and a message of confirmation displays. This concludes calibration. 
You can now work again with Image Control as usual.

Notes on calibration

What happens when calibration is correct?

�
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If measurement was completed successfully and the measured data are within the tolerance range, 
the Heidelberg certification server will create a measurement report and a certificate. Both docu-
ments are sent to the e-mail address set by default. A green bar now displays in the status section.

What happens if the measured data are out of the tolerance range?

The Heidelberg certification server issues a measurement report. But a certificate is not created. The 
calibration status is set to yellow.

In this case, check for the following possible reasons:

• The calibration chart does not match the reference data on the USB stick. 
Make sure that you have the USB stick matching the calibration chart. Load the reference data 
from this USB stick to the measuring device and repeat the measuring process again.

• The calibration chart is damaged 
Request a new calibration chart with a new USB stick.
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Maintenance/Cleaning Instructions
General

Based on the maintenance classification of the press, the maintenance/cleaning activities for 
Prinect Image Control are divided into five maintenance intervals. There are maintenance/clean-
ing activities that the customer must do and servicing/cleaning activities for which the customer 
must request a service technician from HEIDELBERG.

If customers have a service contract (e.g. "Systemservice24"), the service technician will per-
form all servicing/cleaning activities for the customer and service when at the customer's.

Maintenance/Cleaning Intervals

The following five intervals are set for maintenance/cleaning:

Maintenance/Cleaning Activities

The table below lists the required regular maintenance/cleaning activities for Prinect Image 
Control.

The column "C" (second last column) stands for customer and indicates which activities are to 
be performed by the customer. The column "S" (last column) stands for service and indicates 
which activities are to be performed solely by the service technician.

The service technician will also do any customer activities on the day on which he/she will do 
servicing activities. All activities marked by "+" in the column "C" or "S" must be done by the 
customer and/or by the service technician.

Note: National regulations and the information in the respective safety data sheets must be 
complied with when cleaning agents are used!

Category of maintenance interval Time

I Daily

II Weekly

III Monthly

IV Every six 
months

V Once a year

�
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Caution: Damage to the surface! 
Do not spray cleaning agents containing alcohol directly onto the components. Always apply 
the cleaning agent to a soft, lint-free cloth to clean the equipment.

No. Component Maintenance activity/
Maintenance point

Tools Maintenance inter-
val

C S

I II III IV V

1 Console

Filter fan Replace a filter element of the fil-
ter fan in each case in the elec-
tronics slide-in unit on the left 
and right.

X +

2 Measuring table/measuring bar guide

Measuring 
table

Vacuum surface of the measuring 
table.

Note: The measuring bar must be 
in the idle position!

Approved 
industrial vac-
uum cleaner

X +

Guide rails/
guide car-
riage

Clean and lubricate guide rails at 
the front and back.

Slide spray 
Elkalub FLC 
1012, soft, lint-
free cloth, 
observe 
"approved 
lubricants".

X +

Lubricate rear of guide carriage. 2 
funnel-shaped lubricating nip-
ples. Middle or right/left on guide 
carriage.

Lubrication 
gun A03, 
observe 
"approved 
lubricants".

X +

Reference 
white tile/ 
strip

Visually check and, if necessary, 
clean reference white tile and ref-
erence white strip.

Soft, lint-free 
cloth, alcohol 
(e.g. isopro-
pyl), protective 
gloves, 
observe 
"approved 
cleaning 
agents".

X +
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Calibration 
strip

Clean calibration strip. Soft, lint-free 
cloth, alcohol 
(e.g. isopro-
pyl), protective 
gloves, 
observe 
"approved 
cleaning 
agents".

X +

3 Single measuring unit

Single mea-
suring unit

Remove single measuring unit. 
Vacuum LEDs, fan and tracking 
sensor. Remove the unit as 
described in the chapter "Main-
taining and exchanging compo-
nents" in the Prinect Image Con-
trol service manual.

Approved 
industrial vac-
uum cleaner

X +

Colorimetric 
and density 
calibration 
of the single 
measuring 
unit

Check the colorimetric and den-
sity calibration of the single mea-
suring unit Run the check as 
described in the respective user 
manual.

X +

4 Image measuring unit

Image mea-
suring unit

Remove image measuring unit, 
check for dirt and, if necessary, 
vacuum/clean components.

Remove the unit as described in 
the chapter "Maintaining and 
exchanging components" in the 
Prinect Image Control service 
manual.

Soft, lint-free 
cloth, alcohol 
(e.g. isopro-
pyl), brush, 
approved 
industrial vac-
uum cleaner

X +

No. Component Maintenance activity/
Maintenance point

Tools Maintenance inter-
val

C S

I II III IV V
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Index
1up 149
1up archive 155, 186
1up from sample sheet 157

B Bar graph 112
Basic settings measuring device 172

C Central color master database 184
Choose Press 31
Color buttons 106
Color control
Image areas 149

Color Control Block 96
Color Control Strip 96
Color control strip
Definition 96

Color difference
Correctable 111
non-correctable 111

Color master database 184, 206
Color set 74
Control
Run 105

Control element
Control block 96
Mask 96
Minispot 96
Test chart 96

Control elements 187
Delete 97
Enable for control 96
Manual assignment 99

Control panel
Manual operation 29
on the measuring bar 26, 29

Control strip
Definition 96

Correctable color difference 111

D Danger Labels 21
Data table 111
Delete
Control elements 97
Job 63
Messages and device malfunctions 169

Device malfunctions 168
Delete 169

Display
Preview 78, 85, 91, 99, 141, 147

Disposal of the device 36
Dot gain 111

E Edit process standard 193
Electrical data 36
Electronics module 28
Environmental data 36
Export PSO 192

F Foot switch for suction air 28
Footer 33
Front and back
Toggle in Measure/Controls 104, 171

Front and perfecting
Switch between job sections 63

H Header 31, 42
Heidelberg logo 32
Homogeneous Areas 139
Homogeneous areas
Button functions 141, 147
Create 142
Delete 144, 145
Screened color from color database 143

Housing dimensions 35

I Image areas 146, 149
Job workspace 149

Image areas - 1ups 149
Image control via 1ups 149
Image inspection data 116
Image of the printed sheet 108
Import PSO 192
Ink zones
Lock 113
Status 107
Unlock 113

Inking 110
Data table 111

Inking deviation 111
Inking display 111
Invoke Help 32
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